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Changes made compared to version 1.9

Section Heading Change applied

Amended the first paragraph to improve
readability.

Added an important note: When the
submission fails, in the generated error report
CSV, all previously entered data in columns:
‘Volume of sales’, 'Species Identifier’, ‘Species

List of validations on %’ '‘Dose Factor’ and 'Comment’ are removed

the submission file from the file. This ‘system redaction’ is
necessary to prevent MAH users that do not
have roles for all the organisations included in
the submission file, from seeing confidential
data from organisations to which they may not
have access permissions granted.

2.3

Added an important note: When the
submission fails, in the generated error report
CSV, all previously entered data in columns:
MAH validation 'Volume of sales’, 'Species Identifier’, 'Species
e et %°’, ‘Dose Factor’ and '‘Comment’ are removed
e P R e from the file. This ‘system redaction’ is
data CSV necessary to prevent MAH users that do not
have roles for all the organisations included in
the submission file, from seeing confidential
data from organisations to which they may not
have access permissions granted.

2.4
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1. Introduction

This chapter provides guidance on the process of downloading the portfolio of all packages and of
submitting other post-authorisation data (Volume of Sales, Marketing Authorisation Status and
Availability Status) into the Union Product Database (UPD).

This is applicable only for authorised veterinary medicinal products as referred to in Article 5(1) of
Regulation (EU) 2019/6, registered veterinary homeopathic medicinal products as referred to in

Article 85(1) and veterinary medicinal products intended for animals which are exclusively kept as pets
as referred to in Article 5(6) of said Regulation.

The download of the portfolio of packages as a comma separated values (CSV) file is a mandatory
preliminary step, as it will enable the marketing authorisation holder (MAH) to retrieve the package
identifiers from the UPD which are needed for submitting annual volumes of sales and maintaining
availability data. On an ongoing basis MAHs will need to continue to download available packages, to
identify new packages for which sales data or availability status require submission into the UPD.

MAHSs are only responsible for supplying volume of sales and availability status for those Member
States where they either operate or have a distributor directly responsible for the sales in that Member

State:

Parallel Imports: a MAH may be aware that a product is sold/made available in a Member State
through a parallel import, the MAH should not record these sales in that Member State, nor
mark the availability status as ‘marketed’ in that Member State. In this, situation the sale
should continue to be recorded against the Member State from which the parallel import was
sourced.

Special import permits (or equivalent): a MAH may be aware that a product is sold/made
available in a Member State through special import permit, the MAH should not record these
sales in that Member State nor mark the availability status as ‘marketed’ in that Member State.
Where possible, the MAH should record the volume of sales for products with special import
permit against the EEA country where the specific product/pack concerned was actually
authorised. Special imports from countries outside the EEA should not be recorded against an
EEA country but potentially, in certain situations, be part of the third country sales data
reporting submission. For clarity if a product is marketed in Member State A and a special
import permit allows it to be imported into Member State B, the sale for this product should,
where possible, be recorded against Member State A.

MAHs may have sales for an individual Member State product which are then being exported in
a different country. Where the export within the distribution chain is under the control of the
MAH (e.g. a distributor selling on behalf of the MAH into more than one country) then the MAH
should only report sales intended for use within the individual Member State. The exported
sales should be reported for the other Member State or within the non-EEA sales report as
appropriate. Where the export is not directly on behalf of the MAH, then sales should be
recorded within the member State where the initial sale is made.

In cases when the marketing authorisation is transferred from MAH A to MAH B, the MAH B takes over
all responsibilities as the holder of the marketing authorisation which includes reporting of volume of
sales for released batches by MAH A. Therefore, MAH A would have to provide the sales data to MAH B
until end of shelf-life of those batches. It is for the MAH A and MAH B to discuss and decide how and
when this information will be provided from MAH A to MAH B.
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For the purpose of this chapter, annual volume of sales is defined as part of the Other Post
Authorisation Data on a veterinary medicinal product authorised in a Member State with a marketing
authorisation or registration valid on 28 January 2022. All the relevant data elements applicable to
annual volume of sales are outlined in the section 2 of this Chapter.

2. Volume of Sales

During the process of record/submit Volume of Sales the following two operations shall take place
sequentially in the UPD:

e Download of packages: The MAH shall download a structured CSV file from the UPD portal.
This file shall include a portfolio of all packages under the user's responsibility. Such CSV file
shall contain all the raw data stored in UPD for all applicable packages.

e Submission of Volume of Sales: The volume of sales is reported by the MAH for a specific
package, species and country covering a concrete reference period. This information is
submitted through a CSV file previously completed by the user. Information on how to
complete the file is provided in the next sections.

Note:

1. As part of the SPC harmonisation process, products that were previously approved under
national procedures in UPD will now transition to the Mutual Recognition Procedure (MRP).
This change will have the following impacts on the packages:

a. Packages belonging to Concerned Member States (CMS) products will be deleted
and replaced by the packages (and package identifiers) belonging to the Reference
Member State (RMS) product.

b. Itis recommended that the MAH transitions to reporting the Volume of Sales (VoS)
for the new packages as soon as possible (although it will be possible to submit
VoS using the old package identifiers for a period of 2 years).

2. If as a result of a regulatory procedure, the packages of a centralised veterinary medicinal
product are transitioned to a surrendered status, they will not appear in the volume of
sales CSV file downloaded from the system or be visible in the current version of the
product in the UPD. If necessary MAHs should add those surrendered packages manually to
the CSV file to enable a submission, after the date of surrender, of volume of sales figures
from before the date of surrender. The package identifier can be found in previous
download files, previous submissions or earlier versions of the product in the UPD prior to
the change of status to surrendered.

2.1. Volume of Sales data fields

This section describes all fields related to the volume of sales data, either downloaded from the UPD or
provided by the MAH user. The data downloaded from the UPD which are optional for the submission
step (cf. section 2.2) are meant to assist the MAHs in the matching of the UPD Package Identifiers to
the MAH Stock Keeping Units.

The title of each sub section provided below corresponds to the names of CSV file columns. For data to
be entered by the MAH, refer to sections 2.1.11 to 2.1.15.

EU Implementation Guide (Vet EU IG) on veterinary medicines product data in the
Union Product Database
EMA/772580/2022 Page 7/58



The “Conformance” attribute indicates whether a value is mandatory or optional to be provided during
the submission of the CSV file.

2.1.1. Product identifier

The product identifier is applicable to all veterinary medicinal products created in the UPD regardless of
the type of the authorisation procedure. For products registered by European procedures (MRP, DCP
and/or SRP) it is common to all authorisations in the Reference Member State and Concerned Member
States, in addition to e.g., the common authorisation procedure number. It enables linking of products
based on the common/European data set.

Tag Description

User Guidance The product identifier as assigned by the UPD.
Conformance Optional (if provided it will be ignored by the system)
Data Type Identifier (max. 4000 characters)

Value(s) ID generated by the system.

MedicinalProductDefinition.identifier.system value is

“http://ema.europa.eu/fhir/vmpld”

2.1.2. Product name

Tag Description

User Guidance The veterinary medicinal product name (invented name, strength,
pharmaceutical dose form), as indicated in the relevant section of the
corresponding SPC or other regulatory document, in line with the local
language of the country where the product is authorised. Any trademark
values shall not be included in the full veterinary medicinal product name.

Conformance Optional (if provided it will be ignored by the system)
Data Type string (maximum length: 4000 characters)
Value(s) The full veterinary medicinal product name as free text.

Example(s): Metacam 5 mg/ml solution for injection

2.1.3. Permanent identifier

As defined in point 3.1 of Annex III of Commission Implementing Regulation (EU) 2021/16, a
Permanent Identifier (or Permanent ID) is a unique identifier of the veterinary medicinal product in the
Union product database. This Permanent Identifier differentiates between the veterinary medicinal
products authorised in multiple Member States from the same MRP/DCP or SRP (same Product ID
(Level 1). It is generated based on the Product ID (Level 1) with the addition of the national
information as authorised in the country by the relevant competent authority and representing the so-
called ‘national dataset’.
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Tag Description

User Guidance The unique identifier of the veterinary medicinal product as assigned by the
UPD.

Conformance Optional (if provided it will be ignored by the system)

Data Type id

Value(s) ID generated by the system

2.1.4. Authorisation Procedure Number

The procedure number assigned by the competent authority to a specific authorisation/registration
procedure.

Tag Description

User Guidance Number of the initial procedure for marketing authorisation.

Conformance Optional (if provided it will be ignored by the system)

Data Type Identifier

Value(s) The procedure number is specified as free text (max. 4000 characters) but

formatted as: CC/V/nnnn/sss or EMEA/V/C/ for the core part.
Example(s): SE/V/1111/003, DE/V/1111/001, EMEA/V/C/001234

2.1.5. Package Identifier

Volume of Sales are submitted at package level. Therefore, in the submission file, the Package
Identifier is mandatory to be provided. This field is also repeatable as each package can be authorized
for more than one species.

Tag Description

User Guidance The package identifier is generated by the UPD and assigned by the
system to each package.

The package identifier is a mandatory field in the submission file. The
system performs validations whether it belongs to the country indicated in
the file.

For non-EEA countries, the User shall submit only one (estimated
equivalent) EEA package identifier for all non-EEA countries with the total
volume of sales data.

Repeatable Yes

Conformance Mandatory

Data Type Identifier (max. 4000 characters)

Value The package identifier obtained from the UPD system.
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2.1.6. Package description

Tag Description

User Guidance The description of the packaged veterinary medicinal product as specified
in the corresponding SPC and eAF or another regulatory document.

Conformance Optional (if provided it will be ignored by the system)
Data Type Markdown
Value(s) The description of the packaged medicinal product must be provided as

free text (max. 4000 characters).

2.1.7. Pack size

For each Packaged Medicinal Product, the pack size is defined as the total number of units in the
package after reconstitution.

2.1.7.1. Pack size_Numeric value

Tag Description

User Guidance The number of units of presentation of a manufactured item in a packaged
medicinal product.

Conformance Optional (if provided it will be ignored by the system)
Data Type Quantity
Value(s) Numeric value

2.1.7.2. Pack size_Unit of Presentation

Tag Description

User Guidance The unit of presentation describing the unit in which a manufactured item
is presented to describe the strength or quantity as a term ID.

Conformance Optional (if provided it will be ignored by the system)
Data Type CodeableConcept
Value(s) As listed in Units of Presentation (200000000014)

2.1.7.3. Pack size_Unit of Presentation Identifier

Tag Description

User Guidance The identifier of the unit of presentation describing the unit in which a
manufactured item is presented to describe the strength or quantity as
listed in the RMS.
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Tag Description

Conformance Optional (if provided it will be ignored by the system)
Data Type Identifier
Value(s) As listed in Units of Presentation (200000000014)

2.1.8. Country
This section describes the country code of the country where the product is marketed/not marketed.
2.1.8.1. Country

This section describes how to record the country where the package of the medicinal product was sold
in a specific period of time.

Tag Description

User Guidance This field indicates a short name! of the country for which the volume of
sales is submitted. This is not a mandatory field. It can be repeatable
depending on the number of different species for applicable package(s).

Conformance Optional (if provided it will be ignored by the system)
Data Type Text
Value Short name as listed in the Country list (RMS list ID 100000000002), for

all EEA countries. In the cases that volume of sales is being submitted in
non-EEA countries, the country short name should be indicated as “non-
EEA”, as listed in the Country Grouping list (RMS list ID 100000000003)

Example(s): France, Netherlands, non-EEA
2.1.8.2. Country identifier

Tag Description

User Guidance This field indicates a country, for which the Volume of Sales is submitted.
Country code is a mandatory field. It can be repeatable depending on the
number of different species for applicable package(s).

Country identifier is a mandatory field in the submission file and is
validated by the system accordingly.

Repeatable Yes
Conformance Mandatory
Data Type CodeableConcept

! The short name of the country can be found in the RMS list under the column name “Term short name”.
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Tag Description

Value As listed in the Country list (SPOR RMS list ID 100000000002) for all EEA
countries. In the cases that volume of sales is being submitted in non-EEA
countries, the country SPOR RMS term identifier submitted is
"100000000028" (“non-EEA") from RMS list 100000000003 (Country
Grouping list).

In case MS Excel is used for modifying CSV files, the Number format
should be used without decimals.

Example(s): 100000000529 (Spain), 100000000028 (non-EEA)
2.1.9. Marketing authorisation number

Tag Description

User Guidance Marketing Authorisation humber is assigned to the veterinary medicinal
product at product or at package level;

- Marketing authorisation number for authorised veterinary
medicinal products.

- Registration number for registered homeopathic veterinary
medicinal products.

- Declaration number for veterinary medicinal products allowed to be
used in a Member State in accordance with Article 5(6) of
Regulation (EU) 2019/6 or exempted from the provisions in
Articles 5 to 8 of Directive 2001/82/EC in accordance with
Article 4(2) of the same Directive, as applicable.

Conformance Optional (if provided it will be ignored by the system)
Data Type Identifier
Value(s) The number assigned by the competent authority of a country/jurisdiction

shall be specified as free text (max. 4000 characters).

2.1.10. Creation Date of Product

Tag Description

User Guidance The creation date of product describes the date when the product was
created in UPD, as recorded in the audit trail.

Conformance Optional (if provided it will be ignored by the system)
Data Type Date
Value(s) A date specified using the ISO 8601 date format. (YYYY-MM-DD)

In case the MS Excel is used for modifying CSV files, the Date format
should be used.
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2.1.11. Creation Date of Package

Tag Description

User Guidance The creation date of package describes the date when the package was
created in UPD, as recorded in the audit trail.

Conformance Optional (if provided it will be ignored by the system)
Data Type Date
Value(s) A date specified using the ISO 8601 date format. (YYYY-MM-DD)

In case the MS Excel is used for modifying CSV files, the Date format
should be used.

2.1.12. Deletion Date of Package

Tag Description

User Guidance The deletion date of package describes the date when the package was
deleted in UPD, as recorded in the audit trail.

This element is added in the csv download file for convenience of users
since packages deleted in the UPD continue to be present in the download
file for 24 months post deletion.

Conformance Optional (if provided it will be ignored by the system)
Data Type Date
Value(s) A date specified using the ISO 8601 date format. (YYYY-MM-DD)

In case the MS Excel is used for modifying CSV files, the Date format
should be used.

2.1.13. Year-Month

Year-Month represents the period for which the user is submitting the volume of sales at package
level.

Tag Description

User Guidance The Volume of Sales must be provided in monthly increments (i.e., one
line per month). The user must indicate for each line which month and
year the volume of sales reported in that line refers to.

Repeatable No
Conformance Mandatory, entered by MAH user
Data Type dateTime
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Tag Description

Value A date field shall be specified using the ISO 8601 date format (i.e., YYYY-
MM). In case the MS Excel is used for modifying CSV files, the Date format
should be used.

Example: 2023-01; 2024-04
2.1.14. Volume of Sales

This section describes the Volume of Sales of veterinary medicinal products per package, per species,
per country and per month.

Tag Description

User Guidance The Volume of Sales must be provided as an integer number (positive,
negative or 0).

The system shall overwrite previous submissions that were presented for
the same Package Identifier, reference period (month), species and
country. The MAH should contact the relevant NCA/Agency? before
overwriting any previously introduced data to ensure the consumers of
such data are aware that changes have been made.

For non-EEA countries, as the UPD does not contain data on non-EEA
packages, the User shall convert all relevant non-EEA sales into the
equivalent number of packs sold for a target EEA pack (see below). The
volume of sales value shall display the total aggregated value for all
species (in case a package is sold and designated to different/specific
species). This means that the Volume of Sales value should be the same
for each reported species for an individual pack/month (and not the
amount estimated to be sold in that species).

By default, UPD presents the Volume of Sales per package as zero even for
the packages which have not yet been sold so there is no requirement to
submit 0 sales against packs which have not been sold. Similarly, there is
no requirement to submit 0 for non-EEA sales where there have been no
non-EEA sales. Users shall be allowed to add negative values in order to
reflect returns or recalls in the sales data in UPD.

Repeatable No

Conformance Mandatory, entered by MAH user

Data Type Integer

Value The value must be an integer (positive, negative or 0).

Example: 0; 500; -300

2 https://www.hma.eu/veterinary-medicines/cmdv/procedural-contact-points.html
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Important note: many immunological veterinary medicinal products contain both lysophilate and
solvent in the same registered package, however some immunological veterinary medicinal products
(especially poultry vaccines) can have the lysophilate and solvent authorised as separately registered
packages. In this situation the sales for the lysophilate packages must be submitted, but there is no
requirement to submit sales for the separately registered solvent packages.

Possible options/calculations to represent non-EEA sales

Reporting of non-EEA volume of sales must be matched to one or more EEA package identifier(s) (the
package identifier is either a package identifier from a product within the product group (see Section 5)
or one or more package identifier(s) from the specific product for which the non-EEA sales are being
reported). As the same packs are not necessarily sold in the EEA and outside the EEA, the following
approaches should be followed:

Option 1 for non-EEA sales (same pack size exists in EEA):

In the EEA a 50-dose vaccine vial and in non-EEA countries the same 50 dose vaccine vial is used.
Therefore, the volume of non-EEA sales can be reported against that package identifier without
transformation.

For instance, in the Year-Month defined, the Volume of Sales in Brazil was 300,000 vials, in Chile
500,000 and Peru 100,000. Then, non-EEA sales will be reported as new row in the submission file.

Volume of Sales = 900,000
Package identifier = package identifier in EEA with the same combination of pack size/strength
Country Identifier = 100000000028

Option 2 for non-EEA sales (different pack sizes):

In EEA only a 100 ml vial is sold, in non-EEA countries different pack sizes of the same formulation are
sold which the MAH considers to be relevant. For example: 25 packs of 500 ml, 30 packs of 250 ml, 55
packs of 100 ml and 75 packs of 50 ml vials are sold of the same formulation outside the EEA and the
MAH considers all of these relevant. In which case the total number of nominal 100 ml EEA packs sold
= (25 x 500)+(30 x 250)+(55 x 100)+(75 x 50)/100 = 29250/100 = 293 of '100 ml EEA equivalent
packs’ (note volume of sales must be an integer so rounding has occurred).

As above

In the EEA a 50 mg tablet is sold in 10 tablet packs, in some non-EEA countries a 62.5 mg tablet is
sold in 25 tablet packs and which the MAH considers to be relevant. For example: 31 packs of 25
tablets of the 62.5 mg tablet were sold outside the EEA. In which case the total number of equivalents
to the EEA 50 mg/10 tablet packs presentation sold = ((31 x 25) x 62.5/50)/10 = 968.5/10 = 97 of
'10 tablet 50 mg EEA equivalent packs’ (note: volume of sales must be an integer so rounding has
occurred).

Note: if an MAH is not sure about what third country products/presentations should be considered
relevant, the Agency’s or National Competent Authority’s Pharmacovigilance groups should be
consulted.

2.1.15. Estimated distribution across target species

MAHSs shall submit the estimated split of the use per species for each submitted package with sales
(including non-EEA sales), and a dose factor, indicating how many animals of a specific species can be
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treated with one pack on average. In combination, this will allow the subsequent calculation of the
estimated number of treated animals.

2.1.15.1. Species name 3

Tag Description

User Guidance This field enables a species name with the associated sales volumes to be
recorded per package and country.

This field is only provided for the convenience of MAH and there are no
specific rules as to how the MAH uses it.

Only species which are equivalent to those indicated on the EEA SPC
should be included (species splits are not to be provided for non-target
species). There is no requirement to list species which are not indicated in

the EEA SPC.
Conformance Optional (if provided it will be ignored by the system)
Data Type Text
Value(s) This field is only provided for the convenience of MAH and there are no

specific rules as to how the MAH uses it

Examples: Dog; Cat; Cattle
2.1.15.2. Species identifier

Tag Description

User Guidance The species code provided, per package, in the submission file for which
one volume of sales is split.

Species identifier and species splits should only be provided for target
species: no species identifier or species split should be provided for off-
label use (i.e., use in a species not indicated in the EEA / non-EEA country
SPC for EEA / non-EEA as appropriate). Do not list non-target species for
either EEA or non-EEA species splits (based on local SPCs).

For EEA species splits — only species which are equivalent to those target
species indicated on the EEA SPC should be included however there is no
requirement to list all species (for example if the product is not actually
used in a target species, then this species does not need to be listed and if
it is, the full set of data should be provided (e.g. a species split and a
species factor).

For non-EEA species sales data, relevant non-EEA SPC target species
where the product is used should be listed (in practice this means that
species may be listed for non-EEA sales which are not equivalent to any

3Field is not currently available in download file and must not be included in upload file. It will be added in a later release.
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Tag Description

EEA SPC species). Again, there is no requirement to list all non-EEA SPC
target species if the product is not used in some of them.

In the situation where a ‘broad’ target species is listed on an EEA or non-
EEA SPC (examples include but are not limited to ‘fish’, ‘poultry’ etc) and
for which equivalent terms are not present in the RMS Species list, then
the most appropriate term(s) from the RMS Species list should be used.
For example, the indication may be ‘poultry’ but in practice the product is
only used in chicken and turkeys: in this situation ‘chicken’ and ‘turkey’
should be species listed.

Repeatable Yes

Conformance Mandatory, entered by MAH user

Data Type CodeableConcept

Value(s) Term ID as listed in SPOR RMS list Species (200000000019) (Note: this is
not the same as the SPOR RMS Target Species list referred to in the QRD
template).

In case the MS Excel is used for modifying CSV files, the Number format
should be used without decimals.

Examples: 200000000200

2.1.15.3. Species %

Tag Description
User Guidance Many packages of authorised products are sold for use in different animal
species.

Species % represents the numerical value of the estimated percentage of
use of the total sales for a specific package in a given animal species in the
country of reporting.

For EEA sales the total of the species % figures for a specific package
should be 100.

For non-EEA sales the total of the Species % figures for a specific package
should be between 95 and 105.

For packages with only one authorised species, the Species % should be

100.

Repeatable Yes

Conformance Mandatory, entered by MAH user

Data Type Number (figure should not be submitted as a % figure but should be
submitted as a number with or without decimal points - e.g., ‘30’ not
‘30%")
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Tag Description

(Note: 0.35 as the representation of 35% is an incorrect value)

Value(s) Positive number with or without decimal point, between 0 and 100.

In case the MS Excel is used for modifying CSV files, the Number format
should be used with or without decimals. There is no limitation to the
number of decimal points used. However, the number of decimals that will
be displayed when using MS Excel to view the file, depends on the user
settings.

Example(s): Cattle: 35, Dog: 45.5, Cat: 19.5
2.1.16. Dose Factor

Tag Description

User Guidance The Dose factor represents the average number of animals of a particular
species that can be treated using one package. The Dose factor is derived
by the MAH based on his understanding of how the package in question is
generally used in veterinary practice, e.g., taking into account the different
indications for the species, average body weights of animals at treatment,
and suggested treatment plans, i.e. dose, frequency and duration of
treatment) .

The appropriate dose factors should be provided for all volume of sales
data and species per package identifier and per country.

Repeatable No

Conformance Mandatory, entered by MAH user

Data Type Number

Value(s) Positive number with or without decimals. In case of decimals, up to 4

decimal digits can be used.

In case MS Excel is used for modifying CSV files, the Number format
should be used.

Example(s): 0.7; 1.5; 2 ; 1.35; 2.563
2.1.17. Comment

The comment field can be used to indicate any explanations, or to indicate which package the non-EEA
sales for a product have been reported against.

Tag Description

User Guidance Free text field

Conformance Optional (if provided it will be ignored by the system)
Data Type Text
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Tag Description
Value(s) Free text up to 250 characters. N/A

Example: “This package is reporting the non-EEA sales”.
2.2. Submission of Volume of Sales file structure

This section describes the structure of download and submission files. The submission file will be
validated by the system, and therefore the lists of technical and business validation rules are detailed
further in subsection 2.3.

2.2.1. Download of packages file

The Marketing Authorisation Holder shall be able to download a structured CSV file from the UPD
portal. This file includes the portfolio of packages which are under the user's responsibility, including
the relevant data stored in the UPD.

The download file is composed of the fields below. Fields 1 to 15 are automatically pre-filled by the
System (highlighted in bold) according to the rules described in section 2.1. Fields 16 to 21 are empty
in the download file.

1. Product Identifier

2. Product Name

3. Permanent Identifier

4. Authorisation Procedure Number
5. Package Identifier

6. Package Description

7. Pack size_Numeric value

8. Pack size_Unit of Presentation

9. Pack size_Unit of Presentation Identifier
10. Country

11. Country Identifier

12. Marketing Authorisation Number
13. Creation Date of Product (extracted from audit trail)
14. Creation Date of Package

15. Deletion Date of Package

16. Year-Month

17. Volume of Sales

18. Species Identifier (RMS Term ID)

19. Species %

20. Dose Factor

21. Comment

The CSV files exported from the UPD use a comma as field separator. The handling of the downloaded
CSV files depends on the regional settings used on the computer of the end user. Windows computers
with, e.g., a regional setting from a European country is often using semicolons instead of commas to
separate the fields of a CSV file. For more information, please refer to Annex A.

2.2.2. Submission of volume of sales file

The submission file must be submitted in a CSV file format. Further details on how to verify the format
of the file are described in the section 5 from the Annex A.
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The submission file is composed of the following fields: the order of the columns and names of the
column headings must follow the structure below with the content of fields 5, 11 and 16 to 20
validated as mandatory to be provided by the user (highlighted in bold below). Data in other columns
1-4, 6-10, 12-15 do not need to be resubmitted and provided the column header is present, the
columns can either be left blank or information can be included which helps the MAH (e.g., country
name in the Country column).

1. Product Identifier

2. Product Name

3. Permanent Identifier

4. Authorisation Procedure Number
5. Package Identifier

6. Package Description

7. Pack size_Numeric value

8. Pack size_Unit of Presentation

9. Pack size_Unit of Presentation Identifier
10. Country

11. Country Identifier

12. Marketing Authorisation Number
13. Creation Date of Product (extracting from audit trail)
14. Creation Date of Package

15. Deletion Date of Package

16. Year-Month

17.Volume of Sales

18. Species Identifier

19. Species %

20. Dose Factor

21. Comment

2.3. List of validations on the submission file

This section describes technical and business validation rules for the submission file. During the
submission process, the system verifies the data provided in the CSV file. After the submission, the
MAH can check whether that was successful or not by accessing the corresponding “View Volume of
Sales submissions” page under the menu OPAD - Volume of Sales - View Volume of Sales
submissions. In case the submission has failed, an error report CSV file is generated,
containing the validation error messages for each submitted row. The MAH must correct the
original file and repeat the submission until is successful!

Important note: When the submission fails, in the generated error report CSV, all previously entered
data in columns: 'Volume of sales’, 'Species Identifier’, ‘Species %, ‘Dose Factor’ and '‘Comment’ are
removed from the file. This ‘system redaction’ is necessary to prevent MAH users that do not have
roles for all the organisations included in the submission file, from seeing confidential data from
organisations to which they may not have access permissions granted. The MAH user will then need to
use the error report CSV file to identify and correct the issues in the submitted CSV file prior to re-
submission.

2.3.1. Technical validations

Error code Description Error message while submitting the file

Wrong file format. A CSV file is needed. ER.01: Only CSV file format is allowed. Submit option
not available for other file formats
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Error code

Description

Different header column names expected

Different number of columns expected

ER.07
Package identifier cannot be empty

Country Identifier cannot be empty

Year-Month is YYYY-MM (ISO 8601)

ER.17 Default String error message

Volume of Sales is not an integer value
Species Identifier is not a valid value

Species % is not a positive number with or
without a decimal point

Dose factor is not a positive number with or

without a decimal point

Volume of Sales cannot be empty
Species identifier cannot be empty
Species % cannot be empty

Dose Factor cannot be empty
Year-Month cannot be empty

ER.27 Species % value must be between 0 and 100
with or without decimal point
Default Integer error message. In the
message provided the (%) variable will be
replaced by the corresponding column name.

2.3.2. Business validations

Error code Description

Package Identifier provided does not belong
to a product under User's responsibility.

Country Identifier does not exist in RMS list

Package Identifier provided does not belong
to the country selected

Species Identifier needs to be unique per
Volume of Sales cannot be different within

same package, country in the same Year-
Month.

package, country Identifier and Year-Month.

Error message while submitting the file

ER.03: Header column names are not as expected
according to Vet EU IG Chapter 7

ER.04: The number of columns provided is not correct
according to Vet EU IG Chapter 7

ER.07: Country Identifier cannot be empty
ER.08: Package Identifier cannot be empty

ER.13: Year-Month format is not as expected (YYYY-
MM)

ER.17: Comment length is more than 250 characters

ER.18: Volume of sales format is not as expected
(integer value)

ER.19: Species Identifier format is not as expected
(SPOR RMS term ID from Species list 200000000019)

ER.20 Species split format is not as expected (number
with or without decimal point)

ER.21: Dose factor format is not as expected (positive
number with or without decimal point)

ER.22: Volume of sales cannot be empty
ER.23: Species identifier cannot be empty
ER.24: Species % cannot be empty
ER.25: Dose Factor cannot be empty
ER.26: Year-Month cannot be empty

ER.27: Species % value cannot be negative or greater
than 100

ER.28 % is not an integer value

Error message while submitting the file

ERR.01: Package Identifier provided does not belong to
a product under the User's responsibility

ERR.03: Country identifier does not exist in RMS list

ERR.05: Package identifier does not belong to the
country selected.

ERR.12: Species Identifier cannot occur multiple times
for same package, country in the same Year-Month.

ERR.13: Volume of sales cannot be different within
same package, country in the same Year-Month.
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ERR.17

ERR.18

Species identifier does not exist in RMS list

The sum of the split sales per species is not
100, for EEA countries.

Package Identifier provided was deleted
more than 24 months ago.

Package Identifier provided belongs to
nullified product.

Authorisation status changed to revoked or
surrendered more than 24 months ago.

The sum of the split sales per species is not
between 95 and 105 for non-EEA countries.

(Volume of sales must always be the same figure for
same package, country, Year-Month (for all different
species listed))

ERR.14: Species identifier does not exist in RMS list

ERR.16: The sum of split sales per species is not 100
for EEA Sales.

ERR.17: Package Identifier provided was deleted more
than 24 months ago.

ERR.18: Package Identifier provided belongs to a
nullified product.

ERR.19: Authorisation status changed to revoked or
surrendered more than 24 months ago.

ERR.39: The sum of split sales per species is not
between 95 and 105 for non-EEA Sales.

2.4. MAH validation environment for Validation of the sales data CSV

MAH is able to perform a preliminary validation of their CSV file for sales data prior its submission to
the UPD. The submitted CSV file will go through all the same upload and validation steps (including
using the current relevant package identifiers for that MAH) without actually populating the UPD. MAH
may find this useful for the development and validation of their own systems or for checking a CSV file
after corrections have been made. The URL for the validation environment is https://upd-portal-prod-
validation.azurewebsites.net/updwebui/.

Important note: When the submission fails, in the generated error report CSV, all previously entered
data in columns: 'Volume of sales’, 'Species Identifier’, ‘Species %, ‘Dose Factor’ and '‘Comment’ are
removed from the file. This ‘system redaction’ is necessary to prevent MAH users that do not have
roles for all the organisations included in the submission file, from seeing confidential data from
organisations to which they may not have access permissions granted. The MAH user will then need to
use the error report CSV file to identify and correct the issues in the submitted CSV file prior to re-
submission.

3. Marketing Authorisation Status

In case of revocation or suspension of a veterinary medicinal product, the competent authority and the
MAH should agree on who will update the marketing authorisation status in the UPD.

Note that competent authorities are also able to manage in the system the marketing authorisation
status of the veterinary medicinal products under their responsibility and they are the only ones who
can set the status of a veterinary medicinal product to ‘Valid'.

This section describes how MAH is able to update the Marketing Authorisation Status and Marketing
Authorisation Status Date for one product that belongs to the User’s organization.

For the Marketing Authorisation Status update, the possible values to be provided by MAH for the
product selected shall be “suspended” or “revoked”.

Note: if the MA Status is updated to ‘suspended’ or ‘revoked’, then the Availability status is
updated to ‘Not marketed’ and the Availability Status Date to the date of suspension or revocation.
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3.1. Marketing Authorisation status

Tag

User Guidance

Repeatable
Conformance
Data Type

Value

Description

The possible values for the selected product shall be “suspended” or
“revoked” when the Marketing Authorisation status is updated by the MAH.

The remaining Marketing Authorisation statuses are managed exclusively
by competent authorities. Further details can be found in Chapter 2 of the
Vet EU IG.

The status of the marketing authorisation of the medicinal product must be
specified as a term ID.

No
Mandatory, entered by MAH user
CodeableConcept

Must be valid or suspended from the list Regulatory Entitlement Status
(100000072049).

Example: Revoked (100000072121), Suspended (100000072122)

3.2. Marketing Authorisation status date

Tag

User Guidance

Repeatable
Conformance
Data Type
Value

Example: 2022-01-28

Description

The date when the authorisation status changed must be specified. (This
may not be the same as the date when the authorisation status was
updated in the Union Product Database).

No
Mandatory, entered by MAH user
dateTime

A date specified using the ISO 8601 date format. (YYYY-MM-DD)

4. Availability status

During the process of availability status update, the following two operations shall take place

sequentially in the UPD:

e Download of product data file: The Marketing Authorisation Holder shall download, as a result
of a search, the list of packages of the products for which the information on the Availability
Status will be reported. The selected packages are downloaded to the user’s local machine as a
CSV file format whose structure is defined below. See also Annex A for additional advice in
handling CSV files.

e Availability status and availability status date: The Marketing Authorisation Holder shall submit
into the UPD system a CSV file with a fixed structure, providing the Availability status and
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Availability status date per package and country. The full data set that is carried by the CSV
file is presented below. See also Annex A for additional advice in handling CSV files.

Note: As part of the SPC harmonisation process, products that were previously approved under
national procedures in UPD will now transition to the Mutual Recognition Procedure (MRP). This
change will have the following impacts on the packages:

1. Packages belonging to Concerned Member States (CMS) products will be deleted and
replaced by the packages (and package identifiers) belonging to the Reference Member
State (RMS) products.

2. The MAH will need to report Availability status (AvS) for the new packages.

4.1. Availability status data fields

This section describes the mandatory and optional fields related to the provision of the Availability
status and Availability status date data. This mandatory data shall be submitted by Marketing
Authorisation Holders through a file in CSV format (the submission file). The data downloaded from the
UPD which are optional for the submission step (cf. section 4.2) are meant to assist the MAHSs in the
matching of the UPD Package Identifiers to the MAH Stock Keeping Units.

The “Conformance” attribute indicates whether a value is mandatory or optional to be provided during
the submission of the CSV file.

4.1.1. Product identifier

The product identifier is applicable to all veterinary medicinal products created in the UPD regardless of
the type of the authorisation procedure. For products registered by European procedures (MRP, DCP
and/or SRP) it is common to all authorisations in the Reference Member State and Concerned Member
States, in addition to e.g., the common authorisation procedure number. It enables linking of products
based on the common/European data set.

It is applicable to all veterinary medicinal product submitted into the UPD regardless of the type of the
authorisation procedure.

Tag Description

User Guidance The product identifier as assigned by the UPD.
Conformance Optional (if provided it will be ignored by the system)
Data Type Identifier (max. 4000 characters)

Value(s) ID generated by the system.

MedicinalProductDefinition.identifier.system value is

“http://ema.europa.eu/fhir/vmpld”

EU Implementation Guide (Vet EU IG) on veterinary medicines product data in the
Union Product Database
EMA/772580/2022 Page 24/58



4.1.2. Product name

Tag Description

User Guidance The veterinary medicinal product name (invented name, strength,
pharmaceutical dose form), as indicated in the relevant section of the
corresponding SPC or other regulatory document, in line with the local
language of the country where the product is authorised.

Conformance Optional (if provided it will be ignored by the system)
Data Type string (maximum length: 4000 characters)
Value(s) The full veterinary medicinal product name as free text.

Example(s): Metacam 5 mg/ml solution for injection

4.1.3. Permanent identifier

As defined in point 3.1 of Annex III of Commission Implementing Regulation (EU) 2021/16, a
Permanent Identifier (or Permanent ID) is a unique identifier of the veterinary medicinal product in the
Union product database. This Permanent Identifier differentiates between the veterinary medicinal
products authorised in multiple Member States from the same MRP/DCP or SRP (same Product ID
(Level 1). It is generated based on the Product ID (Level 1) with the addition of the national
information as authorised in the country by the relevant competent authority and representing the so-
called ‘national dataset’.

Tag Description

User Guidance The unique identifier of the veterinary medicinal product as assigned by
the UPD.

Conformance Optional (if provided it will be ignored by the system)

Data Type id

Value(s) ID generated by the system

4.1.4. Authorisation Procedure Number

The procedure number assigned by the competent authority to a specific authorisation/registration
procedure.

Tag Description

User Guidance Number of the initial procedure for marketing authorisation.
Conformance Optional (if provided it will be ignored by the system)

Data Type Identifier

Value(s) The procedure number is specified as free text (max. 4000 characters)

but formatted as: CC/V/nnnn/sss or EMEA/V/C/ for the core part.

Example(s): SE/V/1111/003, DE/V/1111/001, EMEA/V/C/001234
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4.1.5. Package identifier

Availability status and date are to be provided at package level. Therefore, in the submission file, the
Package identifier is mandatory to be provided.

Tag Description
User Guidance The package identifier is generated by the system and assigned to each
package.

The package identifier is a mandatory field in the submission file. The
system performs validations whether Package ID belongs to the country
indicated in the file.

Repeatable Yes

Conformance Mandatory

Data Type Identifier (max. 4000 characters)

Value The package identifier obtained from the UPD system.

4.1.6. Package description

Tag Description

User Guidance The description of the packaged veterinary medicinal product as specified
in the corresponding SPC and eAF or other regulatory document.

Conformance Optional (if provided it will be ignored by the system)
Data Type Markdown
Value(s) The description of the packaged medicinal product must be provided as

free text (max. 4000 characters).

4.1.7. Pack size

For each Packaged Medicinal Product, the pack size is defined as the total number of units in the
package after reconstitution.

4.1.7.1. Pack size_Numeric value

Tag Description

User Guidance The number of units of presentation of a manufactured item in a packaged
medicinal product.

Conformance Optional (if provided it will be ignored by the system)
Data Type Quantity
Value(s) Numeric value
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4.1.7.2. Pack size_Unit of Presentation

Tag Description

User Guidance The unit of presentation describing the unit in which a manufactured item
is presented to describe the strength or quantity as a term ID.

Conformance Optional (if provided it will be ignored by the system)
Data Type CodeableConcept
Value(s) As listed in Units of Presentation (200000000014)

4.1.7.3. Pack size_Unit of Presentation Identifier

Tag Description

User Guidance The identifier of the unit of presentation describing the unit in which a
manufactured item is presented to describe the strength or quantity as
listed in the RMS.

Conformance Optional (if provided it will be ignored by the system)
Data Type Identifier
Value(s) As listed in Units of Presentation (200000000014)

4.1.8. Country
This section describes the country code of the country where the product is marketed/not marketed.
4.1.8.1. Country

This section describes how to record the country for availability data submission.
Tag Description

User Guidance This field indicates a short name# of the country for which the availability
data are submitted. This is not a mandatory field.

Conformance Optional (if provided it will be ignored by the system)
Data Type Text
Value Short name as listed in the Country list (RMS list ID 100000000002), for

all EEA countries.

Example(s): France, Netherlands

4 The short name of the country can be found in the RMS list under the column name “Term short name”.
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4.1.8.2. Country identifier

Tag Description

User Guidance This field indicates a country as an identifier. Country identifier is a
mandatory field in the submission file and is validated by the system
accordingly. It can be carried over from the download file.

For submission of availability status file — Country Identifier (field 11), for
Centralised Products, the User shall submit one row per package assigned
to each one of the European Union (EU) Member States, Iceland, Norway,
Liechtenstein, and United Kingdom (Northern Ireland).

Example:

Metacam solution for injection with two packages: the download CSV file
will contain 62 rows (one per each package and country), and the
submission CSV file shall contain up to 62 rows (one row for each package
with availability status changed assigned to each one of the countries).

Repeatable Yes

Conformance Mandatory

Data Type CodeableConcept

Value As listed in the Country list (SPOR RMS list ID 100000000002) for all EEA

countries. In case MS Excel is used for modifying CSV files, the Number
format should be used without decimals.

Example(s): 100000000529 (Spain)
4.1.9. Marketing authorisation number

Tag Description

User Guidance Marketing Authorisation nhumber is assigned to the veterinary medicinal
product at product or at package level:

a.
Conformance Optional (if provided it will be ignored by the system)

Data Type Identifier

Value(s) The number assigned by the competent authority of a country/jurisdiction

shall be specified as free text (max. 4000 characters).

4.1.10. Creation Date of Product

Tag Description

User Guidance The creation date of product describes the date when the product was
created in UPD.

Conformance Optional (if provided it will be ignored by the system)
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Tag Description
Data Type Date

Value(s) A date specified using the ISO 8601 date format. (YYYY-MM-DD)

In case the MS Excel is used for modifying CSV files, the Date format
should be used.

4.1.11. Creation Date of Package®

Tag Description

User Guidance The creation date of package describes the date when the package was
created in UPD.

Conformance Optional (if provided it will be ignored by the system)
Data Type Date
Value(s) A date specified using the ISO 8601 date format. (YYYY-MM-DD)

In case the MS Excel is used for modifying CSV files, the Date format
should be used.

4.1.12. Availability

This section provides information on the availability status of the veterinary medicinal product at
package level. Availability status refers to the concepts of veterinary medicinal product being placed in
the market and the market cessation as applicable.

4.1.12.1. Availability status

Tag Description

User Guidance The status of the marketing of the veterinary medicinal product in the
specified country must be provided by the Marketing Authorisation Holder
as a term ID.

e The term “marketed” should be defined as when the veterinary medicinal
product is “released out of the control of the MAH and into the distribution
chain in destination of a given country”.

e The term “not marketed” should be defined as the “cessation of release
into the distribution chain in destination of a given country” with the
consequence that the concerned product may no longer be available for
supply. It is also the default term when a new product is created.

5 Field is not currently available in download file and must not be included in upload file. It will be added in a later release.
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Tag Description

e The term “temporarily unavailable” should be specified as a disruption of
supply from the MAH which would lead to an extended disruption in supply
to the retailers for a long period of time (e.g. for instance more than 3
months).

Since this information is to be provided by the MAH, at the time of creation
of a new veterinary medicinal product by a Competent Authority the
availability status shall be specified with the value "Not marketed”.

Note: for legacy data (only) at the time the UPD goes live the value “No
data provided” may be present until the MAH updates this.

In some cases, the availability status will be automatically updated by the
system as a result of a change in the marketing authorisation status: A
change of the marketing authorisation status to ‘Surrendered’,
‘Suspended’, ‘Revoked’ or ‘Expired’ will result in a change of the
Availability status to ‘Not marketed’.

Repeatable No

Conformance Mandatory

Data Type CodeableConcept

Value As listed in Marketing Status (RMS list ID 100000072052).

In case the MS Excel is used for modifying CSV files, the Number format
should be used without decimals.

Example(s): 100000072083 (Marketed), 100000072074 (Not Marketed), 230000000000
(Temporarily unavailable) or for legacy data only (at the time the UPD goes live) 100000072075 (No
Data Provided)

4.1.12.2. Availability status date

Tag Description

User Guidance The availability status date describes the date from when the change of
availability status is effective (which may or may not be the date that the
information is uploaded to the UPD).

The first date value will be created by the system, at the time of initial
entry of the product into the UPD by the NCA/Agency (availability status
will be either “not marketed”, “"No data provided”). This date will be empty
if at the time of creation the availability was not provided by the
Competent Authority.

When marketing authorisation holders change the availability status from
this initial entry, the availability status date is mandatory to be provided.

The “Availability Status Date” cannot be set more than the current date +1
day.
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Tag Description

For the initial population of the UPD if the date when the availability status
of the package became effective prior to 28 January 2022 is known, then
this date can be used. If this date is not known or easily accessible, then
the default date of 28 January 2022 (the date of coming into application of
the Regulation) can be used. (Note: this information is not populated into
the Public Portal)

Until the end of 2023 (during which it is anticipated that the availability
status date will be populated by MAH) there is no restriction on the
Availability Status date. From the beginning of 2024, any new Availability
Status date can only be after the current availability status date recorded
in the UPD.

Whenever marketing authorisation holders change the Availability Status,
the Availability Status Date is mandatory to be provided.

Repeatable No

Conformance Mandatory

Data Type Date

Value A date shall be specified using the ISO 8601 date format (i.e., YYYY-MM-

DD). ISO 8601 can accommodate year and month should day of the month
not be known. (i.e., YYYY-MM). In case the DD is not known and only the
YYYY-MM is provided, then as DD, the first day of the submitted month will
be stored in UPD as the Availability Status Day.

In case the MS Excel is used for modifying CSV files, the Date format
should be used.

Example: 2022-01-01; 2023-01
4.2. Availability status data file structure

This section describes the structure of download and submission files. The submission file will be
validated by the system; therefore, the lists of technical and business validation rules are detailed
further in subsection 4.2.3.

4.2.1. Download product data file

The Marketing Authorisation Holder shall be able to download a structured CSV file from the UPD
portal. This file will include the portfolio of packages which are under the user's responsibility and that
match the search criteria selected. Such CSV file shall contain the relevant data stored in UPD for all
applicable packages.

The download file is composed of the fields below. Fields 1 to 13 are automatically pre-filled by the
System (highlighted in bold) according to the rules described in section 4.1

Product Identifier

Product Name

Permanent Identifier

Authorisation Procedure Number (Blank when empty)

Wb
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5 Package Identifier

6. Package Description

7. Pack size_ Numeric value

8 Pack size_Unit of Presentation

9. Pack size_Unit of Presentation Identifier
10. Country

11. Country Identifier

12, Marketing Authorisation Number

13. Creation Date of Product (extracted from audit UPD trail)
14. Availability Status

15. Availability Status Date

The CSV files exported from the UPD use a comma as field separator. The handling of the downloaded
CSV files depends on the regional settings used on the computer of the end user. Windows computers
with, e.g., a regional setting from a European country is often using semicolons instead of commas to
separate the fields of a CSV file. For more information, please refer to Annex A.

4.2.2. Submission of Availability status file structure

The submission file must be submitted in a CSV file format. Further details on how to verify the format
of the file are described in the section 5 from the Annex A.

The submission file is composed of the following fields and the order of the columns and names of the
column headings must follow the structure below with the content of fields 5, 11, 14 and 15 validated
as mandatory to be provided by the user (highlighted in bold below). Data in other columns 1-4, 6-10,
12-13 do not need to be resubmitted and provided the column header is present, the columns can be
either left blank or information can be included which helps the MAH (e.g. country name in the Country
column).

Product Identifier

Product Name

Permanent Identifier
Authorisation Procedure Number
Package Identifier

Package Description

Pack size_ Numeric value

Pack size_Unit of Presentation
Pack size_Unit of Presentation Identifier
10. Country

11. Country Identifier®

12. Marketing Authorisation Number
13. Creation Date of Product

14. Availability Status

15. Availability Status Date

OCROINOU AN

¢ For submission of availability status file — Country Identifier (field 11), for Centralised Products, the User shall submit one row per package
assigned to each one of the European Union (EU) Member States, Iceland, Norway, Liechtenstein, and United Kingdom (Northern Ireland).

Example: Metacam solution for injection with two packages: the download CSV file will contain 62 rows (one per each package and
country), and the submission CSV file shall contain up to 62 rows (one row for each package with availability status changed assigned to
each one of the countries).
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4.3. List of validations on the submission file

This section describes technical and business validation rules for the submission file. During the
submission process, the system verifies the data provided in the CSV file. After the submission, the
MAH can check whether that was successful or not by accessing the corresponding “View Availability
Status and availability date submissions” page under the menu OPAD > Availability Status > View
Availability Status and availability date submissions. In case the submission has failed, an error report
file is generated containing the validation error messages for each submitted row, based on which the
MAH can correct the file and repeat the submission.

4.3.1. Technical Validations

Description Error message while submitting the file

Wrong file format. A CSV file is needed. ER.01: Only CSV file format is allowed. Submit
option not available for other file formats

Different header column names expected ER.03: Header column names are not as
expected according to Vet EU IG Chapter 7

ﬂ Different number of columns expected ER.04: The number of columns provided is not

correct according to Vet EU IG Chapter 7.

Availability Status date cannot be empty ER.06: Availability Status date cannot be
empty
ER.07 Country Identifier cannot be empty ER.07: Country Identifier cannot be empty
ER.08 Package identifier cannot be empty ER.08: Package Identifier cannot be empty

Availability status cannot be empty ER.12: Availability status cannot be empty

Availability Status date YYYY-MM-DD or YYYY-MM ER.14: Availability Status date format is not as
(ISO 8601) expected (YYY-MM-DD or YYYY-MM)

Default Data error message when an update fails due  ER.36: Package could not be updated -

to FHIR validations. As reason, the message returned Reason: <description as returned from FHIR>.

from FHIR server will be displayed. Please try again later and if it still fails, please
raise a Service Desk ticket.
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Recommendation: In case of receiving an error file after the AvS submission, please follow these
steps:

o If the errors in the file are due to business validations (see section 4.3.2), fix the errors and
resubmit the file.
o If the file contains the above ER.36, then you may receive two type of error files:
= In the first case, no updates have been processed successfully. This can be
evidenced by the fact that last column in the error report only contains ER.36 and values
of type 'N/A'. In this case, capture the ER.36 errors in an Excel or CSV file and submit it
as a ticket to EMA Service Now: https://support.ema.europa.eu/, and then resubmit
the part of the file containing values '‘N/A’.
= In the second case, some updates have been processed successfully. This can be
evidenced by the fact that last column in the error report contains ER.36 values and
values of the type ‘Database updated - Submission 0000 - Product 00000’. In this case,
just capture the ER.36 errors in an Excel or CSV file and submit it as a ticket to EMA
Service Now: https://support.ema.europa.eu/. No need to resubmit the part of the file
containing values type ‘Database updated - Submission 0000 - Product 00000’.

o Once the errors of type ER.36 have been addressed, incorporate the AvS of those products
into the next submission, and if you again receive any error repeat all the above steps.

o Overtime, as ER.36 issues are cleaned up, the size of the carry forward from month to
month should diminish in size and eventually disappear.

4.3.2. Business Validations

Description Error message while submitting the file

Package is not under User's responsibility. ERR.01: Package Identifier provided does not
belong to a product under the User's
responsibility

Product Status is not 'Current' or 'Provisional’ ERR.02: Product Status is not 'Current' or
'Provisional' (Availability status can only be
submitted for products with product record

status “Current” or “Provisional”)

Country Identifier does not exist in RMS list ERR.03: Country Identifier does not exist in
RMS list

ERR.04 Availability status does not exist in RMS list ERR.04: Availability status does not exist in
RMS list
Package Identifier provided does not belong to the ERR.05: Package Identifier provided does not
country selected belong to the country selected

ERR.06 Availability Status Date cannot be set more than ERR.06: Availability Status Date cannot be set
current date + 1 day. more than current date + 1 day.
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Products' Marketing authorisation status cannot be ERR.11: Authorisation status cannot be

'Revoked' (100000072121), 'Surrendered' 'Revoked’, 'Surrendered’, 'Suspended' or
(200000010409), 'Suspended' (100000072122) or 'Expired' (Availability status can only be
'Expired'(100000072100) submitted for products with Authorisation

status 'Valid' or 'Pending').

Package Identifier provided was deleted. ERR.20: Package Identifier provided was
deleted

5. MAH Product Grouping

This section describes how MAHs can group different, but related products within the UPD, similar to
the grouping of products within the previous PSUR process.

Important note: It is strongly recommended that MAHs review the training webinar (event page link
here) on this topic before performing product grouping in the UPD.

This functionality enables users to combine safety information for similar EEA products (and similar
non-EEA products via the third country product name submission) in the EVVet datawarehouse
queries, increasing the statistical power and decreasing the administrative burden for all stakeholders
involved. In addition, this will simplify and reduce administrative burden for MAHs with the submission
of Signals and Annual Statements in IRIS, as well as the submission of non-EEA sales data and third
country product names within the UPD.

While this functionality was not envisaged in the Regulation and therefore is not mandatory for MAH to
use, for the reasons above and the benefit of the MAH involved and other stakeholders, it is very
strongly recommended that all MAHs do consider using this functionality for all of the their products
(the only exception where there would not be added value would be where a product is only authorised
in 1 EEA country and not authorised in any other/third country).

During the product grouping process, the following two operations do not necessarily need to take
place sequentially in the UPD, however, it is highly recommended to perform the initial extraction, to
verify the latest UPD product(s) version as well as preventing potential process failure.

e Download of product grouping data: The MAH can download a structured CSV file from the
UPD portal. This file shall include a portfolio of all Permanent Identifiers under the user's
responsibility.

e Submission of product grouping data: The MAH should submit a structured CSV file,
previously completed by the user, to the UPD portal. Information on how to complete the file is
provided in the next sections.

5.1. MAH Product Grouping data fields

This section describes the mandatory and optional fields related to the grouping of products process,
represented by the “Conformance” attribute. The data downloaded from the UPD which are optional for
the submission step (section 5.2.2) are meant to assist on a better understanding of the data
presented.
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5.1.1. Product identifier

The product identifier is applicable to all veterinary medicinal products created in the UPD regardless of
the type of the authorisation procedure. For products registered by European procedures (MRP, DCP
and/or SRP) it is common to all authorisations in the Reference Member State and Concerned Member
States, in addition to e.g., the common authorisation procedure number. It enables linking of products
based on the common/European data set.

It is applicable to all veterinary medicinal products submitted into the UPD regardless of the type of the
authorisation procedure.

Tag Description

User Guidance The product identifier as assigned by the UPD.
Conformance Optional (if provided it will be ignored by the system)
Data Type Identifier (max. 4000 characters)

Value(s) ID generated by the system.

MedicinalProductDefinition.identifier.system value is

“http://ema.europa.eu/fhir/vmpld”

5.1.2. Product name

Tag Description

User Guidance The veterinary medicinal product name (invented name, strength,
pharmaceutical dose form), as indicated in the relevant section of the
corresponding SPC or other regulatory document, in line with the local
language of the country where the product is authorised.

Conformance Optional (if provided it will be ignored by the system)
Data Type string (maximum length: 4000 characters)
Value(s) The full veterinary medicinal product name as free text.

Example(s): Metacam 5 mg/ml solution for injection

5.1.3. Permanent identifier

As defined in point 3.1 of Annex III of Commission Implementing Regulation (EU) 2021/16, a
Permanent Identifier (or Permanent ID) is a unique identifier of the veterinary medicinal product in the
UPD. This Permanent Identifier differentiates between the veterinary medicinal products authorised in
multiple Member States from the same MRP/DCP or SRP (same Product ID (Level 1). It is generated
based on the Product ID (Level 1) with the addition of the national information as authorised in the
country by the relevant competent authority and representing the so-called ‘national dataset’.

Tag Description
User Guidance The unique identifier of the veterinary medicinal product as assigned by
the UPD.
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Tag Description

The permanent identifier is a mandatory field in the submission file and is
validate by the system accordingly.

Conformance Mandatory
Data Type id
Value(s) ID generated by the system

5.1.4. Country
This section describes the country code of the country where the marketing authorisation was granted.
5.1.4.1. Country

Tag Description

User Guidance This field indicates a short name’ of the country where the marketing
authorisation was granted. This is not a mandatory field.

Conformance Optional (if provided it will be ignored by the system)
Data Type Text
Value Short name as listed in the Country list (RMS list ID 100000000002), for

all EEA countries.

Example(s): France, Netherlands
5.1.4.2. Country identifier

Tag Description

User Guidance This field indicates a country as an identifier. Country identifier is an
optional field in the submission file.

Repeatable Yes

Conformance Optional (if provided it will be ignored by the system)

Data Type CodeableConcept

Value As listed in the Country list (SPOR RMS list ID 100000000002) for all EEA

countries. In case MS Excel is used for modifying CSV files, the Number
format should be used without decimals.

Example(s): 100000000529 (Spain)

7 The short name of the country can be found in the RMS list under the column name “Term short name”.
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5.1.5. Procedure type

Tag Description

User Guidance The type of procedure (EU medicinal marketing authorisation approval
routes) through which the initial marketing authorisation was granted by the
regulatory authority.

Conformance Optional (if provided it will be ignored by the system)

Data Type CodeableConcept

Value(s) Short Name as listed in EU Regulatory Authorisation Procedure
(100000154442).

Example(s): DCP
5.1.6. Authorisation Procedure Number

The procedure number assigned by the competent authority to a specific authorisation/registration
procedure.

Tag Description

User Guidance Number of the initial procedure for marketing authorisation.

Conformance Optional (if provided it will be ignored by the system)

Data Type Identifier

Value(s) The procedure number is specified as free text (max. 4000 characters) but

formatted as: CC/V/nnnn/sss or EMEA/V/C/nnnnnn for the core part.
Example(s): SE/V/1111/003, DE/V/1111/001, EMEA/V/C/001234

5.1.7. MAH Product Group Identifier

Tag Description

User Guidance The MAH Product Group Identifier is defined and provided by the MAH user:
it is used by the system to link similar products. Guidance for assessment of
similar products can be found in VICH GL24
(https://vichsec.org/en/guidelines/pharmacovigilance/vich-gls-24-29-35-

42.html)

Conformance Conditional. When the value is left blank, the product is deleted from the
group.

Data Type String (max. 4000 characters)

Value(s) The naming convention for the MAH Product Group Identifier is defined by

the reference ORG-ID, which must be one of the user’s affiliations, followed
by a hyphen (-), and the desired MAH variable product group name or
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Tag Description

reference number. The system supports special characters, as per UTF-8
standard.

Example(s): ORG-100033055-Simparica_Ext
5.2. Product Grouping data file structure

5.2.1. Download Product Grouping data file

The Marketing Authorisation Holder shall be able to download a structured CSV file from the UPD
portal. This file includes the portfolio of products which are under the user's responsibility, including
the relevant data stored in the UPD.

The download file is composed of the fields below. All fields are automatically pre-filled by the System
(highlighted in bold) according to the rules described in section 5.1.

Product Identifier

Product Name

Permanent Identifier

Country

Country Identifier

Procedure type

Authorisation Procedure number (Blank when empty)
MAH Product Group Identifier (Blank when empty)

PNoawRUNE

The CSV files exported from the UPD use a comma as field separator. The handling of the downloaded
CSV files depends on the regional settings used on the computer of the end user. Windows computers
with, e.g., a regional setting from a European country is often using semicolons instead of commas to
separate the fields of a CSV file. For more information, please refer to Annex A.

5.2.2. Submission of Product Grouping file

The submission file must be submitted in a CSV file format. Further details on how to verify the format
of the file are described in section 5 of Annex A.

The submission file is composed of the fields below: the order of the columns and names of the column
headings must follow the structure below with the content of fields 3 and 8 validated as mandatory to
be provided by the user (highlighted in bold below). As previously described in 5.1.7. MAH Product
Group Identifier, field 8 should be submitted empty/blank in order to ungroup a product, therefore, the
submission of an empty value is also processed by the system.

Data in other columns 1-2, 4-7, do not need to be resubmitted and can either be left blank or
information can be included which helps the MAH (e.g., Country name in the Country column).

Product Identifier
Product Name
Permanent Identifier
Country

Country Identifier
Procedure type
Procedure number

MAH Product Group Identifier

ONOUAWNE
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Once the initial MAH Product Group Identifiers have been set up, then products which do not have a
group identifier can be easily identified by filtering the CSV download file for blank values in the MAH
Product Group Identifier column. Products with existing MAH Product Group identifiers should be
deleted from the upload CSV file and only those with new Product Group Identifiers submitted. (To
keep this clean, and to aid the performance of other actions linked with the MAH Product Group
Identifier, it may help MAH to ensure that all products in the UPD have a group identifier even if there
are no other similar EEA or non-EEA products - although this is not mandatory).

5.2.3. Changing a MAH Product Group Identifier

MAH can change the product group identifier for a product or group of products by submitting a new
MAH Product Group Identifier — which will overwrite existing values.

Following the same overwrite approach, when a product or a group of products need to be deleted
from a MAH Product Group Identifier, the correspondent MAH Product Group Identifier (column 8)
cell(s) must be submitted blank/empty to the portal. The UPD interpretates this action as a deletion of
the linkage between the submitted product(s) and the MAH Product Group Identifier.

For cases where a MAH sells a product to another MAH, once the relevant NCA launches the
corresponding transfer of ownership process in UPD, the system will automatically ungroup the
divested product from any other similar products still owned by the original MAH in the EEA or non-
EEA.

5.3. List of validations on the submission file

This section describes technical and business validation rules for the submission file. During the
submission process, the system verifies the data provided in the CSV file. After the submission, the
MAH can check whether that was successful or not by accessing the corresponding “View MAH Product
Grouping submissions” page under the menu OPAD->MAH Product Grouping - View MAH Product
Grouping submissions. In case the submission has failed, an error report file is generated containing
the validation error messages for each submitted row, based on which the MAH can correct the file and
repeat the submission.

5.3.1. Technical validations

Error Description Error message while submitting the file

code

Wrong file format. A CSV file is needed. ER.01: Only CSV file format is allowed. Submit
option not available for other file formats

Different header column names expected ER.03: Header column names are not as
expected according to Vet EU IG Chapter 7

W Different number of columns expected ER.04: The number of columns provided is not

correct according to Vet EU IG Chapter 7.
Permanent Identifier cannot be empty ER.30: Permanent Identifier cannot be empty

File size limit exceeded ER.31: File limit (10MB)
exceeded
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5.3.2. Business validations

Description Error message while submitting the file

Product Status is not 'Current' or 'Provisional’ ERR.02: Product Status is not 'Current' or
'Provisional’.

Product is not under User's responsibility. ERR.33: Product is not under the User's
responsibility.

Product grouping naming convention not as expected ERR.35: Product grouping naming convention
according to Vet EU IG Chapter 7 not as expected according to Vet EU IG
Chapter 7.

The ORG-ID referenced in the MAH Product Group ERR.36: The ORG-ID referenced in the MAH
Identifier is not under the User's responsibility. Product Group Identifier is not under the User's
responsibility.

6. Third Country Product Names

This section describes how MAH can add or update third country product names for products that belong
to the User’s organization. The submission of third country product names can be performed in two
different ways:

- By submitting the information against a MAH Product Group Identifier, impacting all the products
conforming the group of interest.

- Or, in the case MAH third country product name(s) require mapping to MAH owned EEA products
not currently within an MAH product Group (see 5 above), then all relevant third country product
names should be submitted against the Product Identifiers of all relevant MAH owned EEA
products (note: this is a reason why MAH product grouping is strongly recommended - as it
avoids this repeated submission and maintenance of the same data set)

The process of provisioning the third country product names consists in the following two steps:

e Download of Third country product names: This step is not mandatory but highly
recommended as it allows the user to verify the current information in UPD related to the third
country product names. The MAH can download a structured CSV file including the user’s
portfolio.

Related to the rows generated for representing the user’s portfolio, when a product is assigned
to a group via the MAH product grouping (process described in Section 5), the system will not
generate a row for each individual EEA product, instead, EEA products belonging to a group will
solely be represented by the MAH Product Group Identifier:

- If a MAH product group does not have any third country product names already
assigned, the system will show an informative row for the relevant MAH Product Group
Identifier.

- If a MAH product group already has third country product names assigned, there will
be as many rows as third country product names provided for the group.

As per the rows generated for products not belonging to any MAH product group, the system will
represent the product(s) at the EEA product permanent identifier level:
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- If a (non-MAH grouped) EEA product does not have any third country product names
assigned, the system will show an informative row for the relevant product.

- Ifa (non-grouped) EEA product already has third country product names assigned, there
will be as many rows as third country product names provided for the relevant product.

e Submission of Third country product names: The Marketing Authorisation Holder shall
submit the information related to third country product names in a structured CSV file to the
UPD portal (information on how to complete the file is provided in the next sections).

Important notes:

It is recommended that MAH's include all relevant third country product names whether these are fully
authorised/registered in the third country or not (e.g. import permit, conditional licence or do not
require a registration in the third country).

6.1. Third country data fields

This section describes the fields related to the submission of Third Country product names. For each of
these fields, the attribute “"Conformance” included in all the tables within this section will indicate
whether they are mandatory, conditional or optional. Part of the fields downloaded from the database
in the CSV file whose submission is optional (see section 6.2.2 for more detail), are meant to assist
users on a better understanding of the data presented.

6.1.1. MAH Product Group Identifier

Third country product names can be submitted at MAH Product Group identifier or Product identifier
level, depending on whether the product is within a group or not. Therefore, in the download file this
column will be populated if there is any MAH Product Group identifier already submitted to the portal. In
the submission file, a MAH Product Group Identifier or a Product Identifier is mandatory to be provided.
The MAH Product Group Identifier field is also repeatable as each Group can have more than one third
country product name.

Tag Description

User Guidance The MAH Product Group identifier has been assigned by the User following
specifications for the Product grouping management in the section 5 of this
guide.

If the products to which a name is to be associated are already within a MAH
Product Group identifier, then the provision of this field is mandatory to
assign, edit or delete third country product names assigned to that group.
The system performs validations whether all the products within the group
belong to the user responsibility.

If the products to which a third country product name is to be associated are
not linked to a MAH Product Group identifier, then this field is blank in the
download file.

Repeatable Yes

Conformance Conditional
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Tag Description

Data Type String (max. 4000 characters)
Value The MAH Product Group identifier obtained from the UPD system.

Example(s): ORG-100001772-CYLAP HVD,

6.1.2. Product Identifier

Third country product names are submitted at Product Identifier level whenever the product is not within
a MAH Product Group. Therefore, in the submission file, a Product Identifier is mandatory to be provided
for products that are not included in MAH Product Groups. The Product Identifier field is also repeatable
as each Product can have more than one third country product name.

Tag Description
User Guidance The Product identifier is generated by the UPD and assigned by the system.

The Product identifier is a mandatory field in the submission file whenever a
product is not included in a MAH Product Group. The system will
automatically assign the third country product names to the permanent
identifiers under the submitted product identifier for which the user is
responsible for.

Product identifier will be available in the download file if the product does
not belong to any MAH Product Group Identifier.

Repeatable Yes

Conformance Conditional

Data Type Identifier (max. 4000 characters)
Value ID generated by the system.

MedicinalProductDefinition.identifier.system value is
“http://ema.europa.eu/fhir/vmpld”

Example(s): 011f12bf-b267-4ce5-a7d2-1084bfc5d367, 01e08e9d-fa3f-4alb-b588-2037a10bce5f
6.1.3. Product name

Tag Description

User Guidance The veterinary medicinal product name (invented name, strength,
pharmaceutical dose form), as indicated in the relevant section of the
corresponding SPC or other regulatory document, in line with the local
language of the EEA country where the product is authorised. EEA product
names are recorded in the UPD by Competent Authorities at the time of
the product creation.

Conformance Optional (if provided it will be ignored by the system)
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Tag Description
Data Type String (maximum length: 4000 characters)

Value(s) The full veterinary medicinal product name as free text.

Example(s): Metacam 5 mg/ml solution for injection
6.1.4. Country

This section describes the EEA country where the marketing authorisation was granted.
Tag Description

User Guidance This field indicates a short name?® of the EEA country where the marketing
authorisation was granted. This is not a mandatory field.

Conformance Optional (if provided it will be ignored by the system)
Data Type Text
Value Short name as listed in the Country list (RMS list ID 100000000002), for

all EEA countries.

Example(s): France, Netherlands
6.1.5. Permanent identifier

As defined in point 3.1 of Annex III of Commission Implementing Regulation (EU) 2021/16, a
Permanent Identifier (or Permanent ID) is a unique identifier of the veterinary medicinal product in the
Union product database. This Permanent Identifier differentiates between the veterinary medicinal
products authorised in multiple Member States from the same MRP/DCP or SRP (same Product ID
(Level 1).

Tag Description

User Guidance The unique identifier of the veterinary medicinal product as assigned by
the UPD. Permanent Identifier will be available in the download file if the
product does not belong to any MAH Product Group Identifier.

Conformance Optional (if provided it will be ignored by the system)
Data Type Identifier (max. 4000 characters)
Value(s) ID generated by the system

Example(s): 600000239090, 600000242073

6.1.6. Third country product name

The provision of the third country name is mandatory when trying to submit, edit or delete third
country product names.

8 The short name of the country can be found in the RMS list under the column name “Term short name”.
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Tag Description

User Guidance The name of the veterinary medicinal product authorised in a country which
is not a member of the European Economic Area.

Repeatable Yes

Conformance Mandatory

Data Type String (max. 4000 characters)

Value The relevant third country product name as free text. The system supports

special characters, as per UTF-8 standard.

Example(s): CYLAP HVD, CYLAP RCD VACCINE
6.1.7. Third Country identifier

Tag Description

User Guidance This field indicates the third country, for which the product name(s) is/are
submitted. Country code is a mandatory field. It can be repeatable
depending on the number of different product names for applicable product.

Country identifier is a mandatory field in the submission file. The system
only accepts RMS terms having as Extended Attribute®; Country Grouping
equal to “non-Eeuropean Economic Area — non-EEA”.

Repeatable Yes

Conformance Mandatory

Data Type CodeableConcept

Value As listed in the Country list (RMS list ID 100000000002)

Example(s): 100000000354 (Canada), 100000000361 (Republic of Chile)

6.1.8. Third Country Name

Tag Description

User Guidance This field indicates a short name? of the non-EEA country for which the
product name(s) is/are submitted. This is not a mandatory field. It can be
repeatable depending on the number of different product names for
applicable product.

9 All RMS Terms from SPOR - Referentials Management System are defined by a set of attributes: Identifier, Operational
Attributes, Term Name, Status, Short Name, Domain, Mapping, Data Classification and Extended Attributes. The Country
Grouping is a representative Extended Attribute from the Country RMS terms available in the Country RMS list.

10 The short name of the country can be found in the RMS list under the column name “Term short name”.
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Tag Description

Repeatable Yes

Conformance Optional (if provided it will be ignored by the system)
Data Type Text

Value As listed in the Country list (RMS list ID 100000000002)

Example(s): Canada (100000000354), Chile (100000000361)
6.1.9. Delete

This column is to define the action the user wants to undertake, per row, at the submission file. This is
always empty for a download file but must be defined for a submission file. The user can add new third
country product name(s) for a MAH Product Group identifier or a Product Identifier assigning the value
FALSE to the column Delete. If the user needs to remove or rename an existing third country product
name, the value to be assigned to the column Delete for that specific row must be TRUE.

Tag Description

User Guidance Delete column is mandatory to define the action, add or remove, of a third
country product name, per row. For updating a third country product name,
the record to be renamed should be submitted with “Delete=True”, and the
new desired name of interest should be submitted in a separate row with
“Delete=False”.

Repeatable Yes

Conformance Mandatory (for submission file)

Data Type Binary (True or False)

Value True = to remove an existing third country product name. False = to add a

new third country product name to a MAH Product Identifier or to a Product
Identifier (if the Product Identifier does not belong to a MAH Product Group
Identifier). It is case insensitive.

Example(s): True, TRUE, False, FALSE
6.2. Third country data file structure

6.2.1. Download Third Country Product Names file

The Marketing Authorisation Holder shall be able to download a structured CSV file from the UPD
portal. This file includes the portfolio of products which are under the user's responsibility, including all
relevant third country product names submitted to the UPD.

The download file is composed of the fields below. Fields 1 to 8 are pre-filled by the System
(highlighted in bold), according to rules described in the introduction of section 6. Field 9 is always
empty in the download file.

1. MAH Product Group Identifier
2. Product Identifier
3. Product Name
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Country

Permanent Identifier

3rd country product name
3rd country identifier

3rd country name

Delete

PoONanh

The CSV files exported from the UPD use a comma as field separator. The handling of the downloaded
CSV files depends on the regional settings used on the computer of the end user. Windows computers
with, e.g., a regional setting from a European country is often using semicolons instead of commas to
separate the fields of a CSV file. For more information, please refer to Annex A.

6.2.2. Submission Third country product names file

The submission file must be submitted in a CSV file format. Further details on how to verify the format
of the file are described in section 5 of Annex A.

The submission file is composed of the fields below: the order of the columns and names of the column
headings must follow the structure below.

- Content of fields 1 or 2, are mutually exclusive, one of them must contain data.
- Content of fields 6, 7 and 9 are validated as mandatory to be provided by the user.

- Datain columns 3,4,5 and 8 do not need to be submitted, can either be left blank or
information can be included which helps the MAH (e.g. country name in the Third country
name column).

MAH Product Group Identifier
Product Identifier

Product Name

Country

Permanent Identifier

3rd Country Product Name
3rd Country Identifier

3rd Country Name

Delete

VCONGAUAWNR

6.2.3. Uploading or updating Third country product names

MAH can upload third country product names or update (rename) or delete existing ones against a
Product identifier or a MAH product group identifier. The user specifies these actions to the system
through the column Delete in the CSV file. This column only accepts two values, true or false, and it
enables MAHSs to perform the following actions:

- If the MAH wants to submit a new non-EEA product name, a row with the new record should be
submitted with Delete = False. The system will store the new third country name to the group
or product of interest.

- If the MAH wants to delete a non-EEA product name stored for a group or a product, a row
with this third country name record should be submitted with Delete = True. The system will
erase the existing third country name of interest from the relevant group or product of
interest.

- If the MAH wants to update/rename a non-EEA product name stored for a group or a product,
two different rows should be submitted to result in an update operation; the old record to be
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renamed should be submitted with “Delete=True”, and the new desired name of interest
should be submitted with “"Delete=False”

These actions can be submitted simultaneously within the same submission file.

6.2.4. Changes to MAH product grouping when possessing Third
country product names

- UPD will automatically perform certain actions when a MAH Product Group Identifier has
already Third country product names stored in the database, and the composition of the MAH
Product Group varies as a result of products additions and deletions to the group. If a product
or group of products are successfully submitted to a MAH Product Group Identifier (section
5.2.2), and the system recognizes that the group already has Third country product names
assigned to it, the UPD will automatically link the Third country product names to the new
product(s) conforming the group. MAHs are not requested to resubmit this information in a
later stage.

- If a product or group of products are deleted from a MAH Product Group Identifier (section
5.2.3), and the system recognizes that the group already has Third country product names
assigned to it, the UPD will automatically unlink the Third country product names to the
product(s) removed from a group. MAH are not requested to resubmit this information in a
later stage.

6.3. List of validations on the submission file

This section describes technical and business validation rules for the submission file. During the
submission process, the system verifies the data provided in the CSV file. After the submission, the
MAH can check whether that was successful or not by accessing the corresponding “View Third Country
Product Name submissions” page under the menu OPAD - Third Country Product Names - View Third
Country Product Name submissions. In case the submission has failed, an error report file is generated
containing the validation error messages for each submitted row, based on which the MAH can correct
the file and repeat the submission.

6.3.1. Technical validations

Error Description Error message while submitting the file
code
Wrong file format. A CSV file is needed. ER.01: Only CSV file format is allowed. Submit
option not available for other file formats.
Different header column names expected. ER.03: Header column names are not as
expected according to Vet EU IG Chapter 7.
Different number of columns expected. ER.04: The number of columns provided is not
correct according to Vet EU IG Chapter 7.
Group Identifier OR Product Identifier must be ER.32: MAH Product Group Identifier OR
populated. Cannot have both empty. Product Identifier cannot be empty.
Both Group Identifier AND Product Identifier both ER.33: MAH Product Group Identifier AND
populated. Cannot have both with data. Product Identifier cannot be simultaneously
provided in the same row.
W Delete column is empty. ER.34: Delete field cannot be empty.
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Error
code

ER.37

Description

3 Country Product Name cannot be empty.

3 Country Identifier cannot be empty.

6.3.2. Business validations

Error
code

ERR.27

ERR.28

Description

Product Status is not 'Current' or 'Provisional’

Country Identifier does not exist in RMS list

Group Identifier exists in the UPD.

User is not affiliated to the Organization Identifier
linked to the MAH Product Group Identifier.

3rd Country Identifier RMS does not have the
extended attribute of country grouping as non-
European Economic Area - non-EEA.

3rd data set is not associated to the Product
Identifier (when delete=TRUE)

3rd data set is not associated to the Group identifier
(when delete=TRUE)

Product is not under the user's responsibility

Product identifier is associated to a MAH Product
Group Identifier. User can submit 3rd country data to
a product identifier, when the product has no group
assigned

Error message while submitting the file

ER.35: 3™ Country Product Name cannot be
empty.

ER.37: 3™ Country Identifier cannot be empty.

Error message while submitting the file

ERR.02: Product Status is not 'Current' or
'Provisional'.

ERR.03: Country Identifier does not exist in
RMS list.

ERR.25: MAH Product Group Identifier does not
exist in the UPD.

ERR.26: Product(s) comprising the MAH
Product Group Identifier is/are not under User's
responsibility.

ERR.27: 3™ Country Identifier is not an RMS
term with a non-EEA recognized Identifier

ERR.28: 3rd country data submitted for
deletion does not exist for the Product
Identifier of interest.

ERR.29: 3rd country data submitted for
deletion does not exist for the MAH Product
Group Identifier of interest.

ERR.33: Product is not under the User's
responsibility.

ERR.37: Product Identifier belongs to the MAH
Product Group Identifier "Identifier of interest".
Consider submitting 3rd Country product
names against the group.
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Annex A
1. How to check if the format of the downloaded CSYV file is correct

Depending on the configured region in the windows installation and mainly due to different decimal
separators, the downloaded templates cannot be properly opened as excel files and all data split across
the specified columns.

A. In order to check this, the downloaded comma separated values (CSV) files should be right-
clicked and opened as Excel file (if it is not possible to directly open it as an Excel file). It is
highly recommended to open a CSV file by using the Excel menu option Data > Get Data >
From File > From Text/CSV as shown in the following image

File Home Insert Page layout Formulas Data Review View Help

fﬁ [® From Textycsv [® Recent Sources D‘J [T Queries & Connections @ l@'
@ [% From Web [‘r\_-| Existing Connections =] @ v
Get Refresh — Stocks Currencies =
Data ~ B From Table/Range All ~
onnections Data Types
From File > [E From Excel Workbook

= From Text/CSV

[ ] From Database > E From Text/CSV

— Import data from a text,

comma-separated value or K
& From Azure > From XML formatted text (space-delimited)
n file.

From Power Platform 7 From JSON

[E) From Online Services > From PDF

5B E

I:I(a3 From Other Sources > From Folder
g Combine Queries > [E From SharePoint Folder

@ Launch Power Query Editor...
[%. Data Source Settings...

Query Options
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B. A correctly delimited file should open as in the following image:

File Home Insert Pagelayout Formulas Data Review View Help 1 Comments 2 Share
[% From Text/CSV [& Recent Sources |_ [T Queries & Connections - ? <7 =] E ﬁ Sa ﬁl % 8H Group ~ =
30 fi :
[é From Web [F] Existing Connections @ ~ ) 2 () > ’_i] ? 2H Ungroup ~
Get - Refresh ™ Stocks Currencies = z | Sort Filter Text to What-If Forecast
ES From Table/R: ™ = | &) ] ; EH subtotal
Data v i EE AL All~ | EAdvanced Columns & J: Analysis ¥ Sheet Eff ~ubtotal
Get & Transform Data Queries & Connections Data Types Sort & Filter Data Tools Forecast Qutline [ 1
@ POSSIBLE DATA LOSS Some features might be lost if you save this workbook in the comma-delimited (.csv) format. To preserve these feanh’*“_(es save it in an Excel file format. Don't show again Save As... b
K11 - fe '
0 Internal \ All EMA Staff and Contractors /° Private Public Internal ~  Confidential ~ Restricted
| A B C D E F G H J K L M N O [
1 |Product Identifier Product Name Permanent Identifier Authorisation Proc Package Identifii Package D Pack size_| Pack size_! Pack size_Unit of F Country  Country Identifier Marketing Creation Date ¢ Availability Status Availability Status
2 |5ch0b6fb-9d20-464 FUREX Combi 15.5 mg/g / 77 600000150555 ES/V/0360/001 54ade196-fedd- Carton bo; 1 Syringe 200000002150 Cyprus 100000000375 GR123 08/12/2021 100000072075  08/12/2021
3 |5cb0b6b-9d20-464 FUREX Combi 15.5 mg/g / 77 600000150555 ES/V/0360/001 54ade196-fedd- Carton bo: 1 Syringe 200000002150 Spain 100000000529 GR123 08/12/2021 100000072075  08/12/2021
4 |623b9138-2c75-4a€ Antirobe vet. 150 mg Kapsel; 600000161870 Not available 20fd7a88-0991- Tryckforpe 80 Capsule 200000002113 Sweden 100000000535 11648 23/12/2021 0
5 |623b9138-2c75-4a€ Antirobe vet. 150 mg Kapsel; 600000161870 Not available 451fd721-ed28- Tryckforpe 16 Capsule 200000002113 Sweden 100000000535 11648 23/12/2021 0
C. An incorrectly delimited file will open as in the following image:
File Home Insert Page Layout Formulas Data Review View Help 1 Comments 5 Share
A av = T AutoSum  ~
X cu n Jxx|==F o Bwewe J B B SRE 2 by O
[®copy ~ ” Fill ¥ : {
Paste = = = Conditional Formatas Cell Insert Delete Format Sort & Find & Analyse
I U~ She A | === v &~ 9 <0 .00 y:
v <¥ Format Painter - — - - = s CeiiE v o % 9 W B Formatting ¥ Table ¥ Styles v v v - 6) Clear v Filter v Select ¥ Data
Clipboard & Font [ Alignment N Sensitivity MNumber [ Styles Cells Editing Analysis
Al - Je Product Identifier,Product Name,Permanent Identifier,Authorisation Procedure Number, Package Identifier,Package Description,Pack size_Numeric value,Pack size_Unit of Presentation,Pack size_Unit of Presentation
0 Internal \ All EMA Staff and Contractors /' Private Public Internal  ~  Confidential ~ Restricted
A B C D E F G H 1 ) K L M N o P Q R S T u v W X Y z Al

lFruduct Idantifier,Pluduct Name,Permanent Identifier,Authorisation Procedure Number,Package Identifier,Package Description,Pack size_Numeric value,Pack size_Unit of Presentation,Pack size_Unit of Presentation Identifier,Country,Country Identifier, Marketing Authorisation Number,Cre
5ch0b6fb-9d20-464d-abbe-3f9d30ebbea8, FUREX Combi 15.5 mg/g / 77.5 mg/g otopatkn ndota - UAT Training 0812,600000150555,E5/V/0360/001,54ade196-fedd-49e1-9a64-58bde2b881a2,Carton box of 1 syringe for oral administration of 7.74g,1,5yringe, 200000002150, Cyprus, 1
5ch0b6fb-9d20-464d-abbe-9f9d90ebbea8, FUREX Combi 15.5 mg/g / 77.5 mg/g otopatkr) ndota - UAT Training 0812,600000150555,E5/V/0360/001,54ade196-fedd-49e1-9a64-58bde2b881a2,Carton box of 1 syringe for oral administration of 7.74g,1,Syringe,200000002150,Spain, 1
623b9138-2c75-4a6f-8861-9c50b766ea26,Antirobe vet. 150 mg Kapsel; hard,600000161870,Not available,20fd7a88-0991-426c-a756-7bfb927{7c16, Tryckfdrpackning; 80 kapslar,80,Capsule,200000002113,5weden, 100000000535,11648,23/12/2021,0,
623b9138-2c75-4a6f-8861-9c50b766ea26,Antirobe vet. 150 mg Kapsel; hard,600000161870,Not available,451fd721-ed28-459f-a32e-e6e740ef1a65, Tryckférpackning; 16 kapslar,16,Capsule,200000002113,5weden, 100000000535,11648,23/12/2021,0,

woE W =

D. As you can see the first file has data in clearly separated columns whereas in the second case all data are packed in the first column (column A). As
the first case does not need any modifications, we are going to focus on how to upload a comma separated values (CSV) file that is downloaded and
then opened in Excel as it is depicted in the second case.
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2. How to change the format of an incorrectly formatted comma separated values (CSV) file

In case the downloaded comma separated values (CSV) file is presented as in the second case of the above section then perform the following steps:

A. Select Column A as it is displayed in the following image:

File Home Insert Pagelayout Formulas Data Review View Help i1 Comments 2 Share
~ g =" AutoSum  ~
% cu ST A 2 Wiap Text [ | foencra D B B B=RE by O
(3 copy ~ ) - Fill ~ g
Paste Sensitivity - Conditional Formatas Cell Insert Delete Format Sort & Find & Analyse
I U~ S A v &= v O 0 .00
v <¥ Format Painter - — e f e < &8 % 9 % Formatting ¥ Table ¥ Styles ~ v © © & Clear ¥ Filter v Select v Data
Clipboard N Font N Alignment Nl Sensitivity Number ~ Styles Cells Editing Analysis
Al - Je Product Identifier,Product Name,Permanent Identifier,Authorisation Procedure Number,Package Identifier,Package Description,Pack size_Numeric value,Pack size_Unit of Presentation,Pack size_Unit of Presentation
0 Internal \ All EMA Staff and Contractors /' Private Public Internal - Confidential ~ Restricted
A B C D E F G H 1 J K L M N o P Q R s T u v W X Y z Al

Product Identifier,Pfoduct Name,Permanent Identifier,Authorisation Procedure Number,Package Identifier,Package Description,Pack size_Numeric value,Pack size_Unit of Presentation,Pack size_Unit of Presentation Identifier,Country,Country |dentifier, Marketing Authorisation Number,Cre:
5cb0b6fb-9d20-464|d-abbe-9f9d90ebbead, FUREX Combi 15.5 mg/g / 77.5 mg/g otopatkr ndota - UAT Training 0812,600000150555,E5/V/0360/001,54ade196-fedd-49e1-9a64-58bde2b881a2,Carton box of 1 syringe for oral administration of 7.74g,1,5yringe, 200000002150, Cyprus, 100000
5cb0b6fb-9d20-464/d-abbe-9f9d90ebbea8,FUREX Combi 15.5 mg/g / 77.5 mg/g atopatkr ndaata - UAT Training 0812,600000150555,E5/V/0360/001,54ade196-fedd-49e1-9a64-58bde2b881a2,Carton box of 1 syringe for oral administration of 7.74g,1,Syringe,200000002150,5pain, 10000001
623b9138-2c75-4al5f-8861-9c50b766ea26,Antirobe vet. 150 mg Kapsel; hird,600000161870,Not available,20fd7a88-0991-426¢-a756-7bfb927f7c16, Tryckfdrpackning; 80 kapslar,80,Capsule,200000002113,Sweden,100000000535,11648,23/12/2021,0,
623b9138-2c75-4alif-8861-9c50b766ea26,Antirobe vet. 150 mg Kapsel; hard,600000161870,Not available,451fd721-ed28-459f-a32e-e6e740ef1a65, Tryckfdrpackning; 16 kapslar,16,Capsule,200000002113,5weden,100000000535,11648,23/12/2021,0,

o b=

B. Press "Data" menu and then select "Text to Columns" in the ribbon as it is displayed in the following image (having Column A still selected):

File Home Insert Page layout Formulas Data Review View Help {1 Comments 1 Share
[ B From Test/csv [® Recent Sources |rb. [T Queries & Connections = A 5% ﬁ\ g_@ 8HGroup ~ =
30 i : : i
[® From Web [® Bxisting Connections = @ v | 2 ") @Hungroup ~ =
Get B Refresh — Stocks Currencies | = zl Sort Filter What-If Forecast c
Data ~ EH From Table/Range Al [ A & Advanced Analysis ¥ Sheet Effl subtotal
Get & Transform Data Queries & Connections Data Types Sort & Filter Forecast Qutline N
Al - S Product Identifier,Product Name, Permanent Identifier, Authorisation Procedure Number,Package Identifier,Package Description,Pack size_Numeric value,Pack size_Unit of Presentation,Pack size_Unit of Presentation §
0 Internal \ All EMA Staff and Contractors Private Public Internal - Confidential ~ Restricted
A B z D E F G H I J K L M N o P Q R 3 T u v w X Y Z A
1 [Product Identifier,Ftoduct Name,Permanent Identifier, Authorisation Procedure Number,Package Identifier,Package Description,Pack size_Numeric value,Pack size_Unit of Presentation,Pack size_Unit of Presentation Identifier,Country,Country Identifier,Marketing Authorisation Number,Cre
2 |5cb0b6fb-9d20-464|d-abbe-9f9d90ebbea8, FUREX Combi 15.5 mg/g / 77.5 mg/g otopankr ndota - UAT Training 0812,600000150555,E5/V/0360/001,54ade196-fedd-49e1-9a64-58bde2b881a2,Carton box of 1 syringe for oral administration of 7.74g,1,Syringe, 200000002150, Cyprus, 100000
3 |5cb0b6fb-9d20-464|d-abbe-9f9d90ebbea8,FUREX Combi 15.5 mg/g / 77.5 mg/g otopatkr nédota - UAT Training 0812,600000150555,E5/V/0360/001,54ade196-fedd-49e1-9a64-58bde2b881a2,Carton box of 1 syringe for oral administration of 7.74g,1,5yringe,200000002150,Spain, 1000000
4 |623b9138-2c75-4ai5f-8861-9c50b766ea26,Antirobe vet. 150 mg Kapsel; hard, 600000161870, Not available,20fd7a88-0991-426¢-a756-7bfb927f7c16, Tryckférpackning; 80 kapslar,80,Capsule,200000002113,Sweden,100000000535,11648,23/12/2021,0,
5 |623b9138-2c75-4alj-8861-9c50b766ea26,Antirobe vet. 150 mg Kapsel; hard, 600000161870, Not available,451fd721-ed28-459f-a32e-e6e740ef1a65, Tryckfrpackning; 16 kapslar,16,Capsule,200000002113,Sweden,100000000535,11648,23/12/2021,0,
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C. Verify "Delimited” is selected and press "Next" in the popped-up screen as it is displayed in the following image:

2 Comments

2 Share

File Home Insert Page Layout Formulas Data Review View Help
[ From Text/Csv [& Recent Sources [1; T Queries & Connections o ? N2 =) E 4 8= @ &EI 8HGroup ~ =
[ From Web [® Existing Connections = E @ S ¥ : 2 <9 B =8 u @HUngroup ~ =
Get Stacks Currencies |= Z»L Sort Filter Text to What-If Forecast -
Data ~ & From Table/Range [“ A ﬁAdvanced Columns £ ~ @ Analysis ¥ Sheet Em Subtotal
Get & Transform Data Queries & Connections Data Types Sort & Filter Data Tools Forecast Outline [

Al - e Product Identifier,Product Name,Permanent Identifier,Authorisation Procedure Number,Package Identifier,Package Description,Pack size_Numeric value Pack size_Unit of Presentation,Pack size_Unit of Presentation
0 Internal \ All EMA Staff and Contractors ¢/ Private Public Internal Confidential ~ Restricted

A B | C | D | E | F | G | H | I | J | K | L | M | N | o | P | Q | R | 5 | I | u | v | w | X | Y | z A
1 |Product Identifier,Pfoduct Name,Permanent Identifier,Authorisatiof . resentation,Pack size_Unit of Presentation Identifier,Country,Country Identifier,Marketing Authorisation Number,Cre:

Convert Text to Columns Wizard - Step 1 of 3 ? X . L . .
2 |5cb0b6fb-9d20-464|d-abbe-9f9d90ebbea8, FUREX Combi 15.5 mg/g 9a64-58bde2b881a2,Carton box of 1 syringe for oral administration of 7.74g,1,5yringe, 200000002150, Cyprus, 100000
3 |5cbOb6fb-9d20-46¢ d-abbe—SdeSOebbaaB,FUR.EX Combi 15.5 mg/g The Text Wizard has determined that your data is Fixed Width. +9a64-58bde2b881a2,Carton box of 1 syringe for oral administration of 7.74g,1,5yringe,200000002150,5pain, 1000000
4 |623b9138-2c75-4alhf-8861-9c50b7662a26,Antirobe vet. 150 mg Ka lapslar,80,Capsule, 200000002113, 5weden, 100000000535,11648,23/12/2021,0,
5 |623b9138-2c75-4albf-8861-9c50b766ea26,Antirobe vet. 150 mg Kq If this is correct, choose Next or choose the data type that best describes your data. apslar,16,Capsule, 200000002113, 5weden, 100000000535,11648,23/12/2021,0,
6 Original data type
7
5 Choose the file type that best describes your data:
9 @J]e\imit_eq - Characters such as commas or tabs separate each field
10 O Fixed width - Fields are aligned in columns with spaces between each field.
11
12
13
14
15
16
17 Preview of selected data:
18
19 Product Identifier,Product Name,Permanent Identifier,Authorisation Procedul
cbOb6fb-9d20-464d-abbe-9£9d30ebbeas, FUREX Combi 15.5 mg/g / 77.5 mg/g oto

20 cbOb6£fb-9d20-464d-abbe-9£5d30ebbead, FUREX Combi 15.5 mg/g / 77.5 mg/g oto
21 23b9138-2c75-4a6£-8861-9c50bT66ea2é, Antirobe vet. 150 mg Kapsel; hérd, 600
2 623b9138-2c75-4a6£-8861-9c50bTE62a26, Antirobe vet. 150 mg Kapsel; hard, 600
23 le]
24 < >
25
= Cancel < Back Einish
27
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D. Uncheck "Tab" and check "comma" as displayed in the image below:

File Home Insert Pagelayout Formulas Data Review View Help
[ From Text/csv [® Recent Sources [ », [ Queries & Connections ﬁ l__W
P [é From Web [E Existing Connections [£] =2 © oy
< o Stocks C les [ | 2] °°
Data ~ EH From Table/Range [ oc drrencies il
Get & Transform Data Queries & Connections Data Types

! Comments = Share
N EE # B8e ER @ Group ~ =
| 2 <'> g F‘C] ’? @B ungroup ~ =
Filter Text to = What-If Forecast C
& Advanced | Columns E® ~ [ | Analysis~ Sheet | i Subtotal
Sort & Filter Data Tools Forecast Outline ]

Product Identifier,Product Name,Permanent Identifier,Authorisation Procedure Number,Package Identifier,Package Description,Pack size_ Numeric value,Pack size_Unit of Presentation,Pack size_Unit of Presentation

Al -
&7 Internal \ All EMA Staff and Contractors /' Private Public Internal  ~  Confidential ~ Restricted
A B C D E F G H 1 J K L M N o P Q R s T u \ W X Y z A
1 |Product Identifier,Pfoduct Name,Permanent Identifier,Authorisatio ~ B Presentation,Pack size_Unit of Presentation Identifier,Country,Country Identifier,Marketing Authorisation Number,Crez
2 |5cbOb6fb-9d20-462)d-abbe-9f9d90ebbeat, FUREX Combi 15.5 mg/g CONVert Text to Columns Wizard - Step 2 of 3 ¢ L9a64-58bde2b881a2, Carton box of 1 syringe for oral administration of 7.74g,1,Syringe, 200000002150, Cyprus, 100000,
3 |5ch0befb-9d20-46¢) d-abbe-SdeSUebbeaS,FUR.EX Combi 15.5 mg/g i s S e e i A e i g 6 i s oo e s s (s ez i r9ab4-58bde2b881a2,Carton box of 1 syringe for oral administration of 7.74g,1,Syringe,200000002150,5pain, 1000000(
4 |623b9138-2¢75-4alif-8861-9c506766ea26,Antirobe vet. 150 mg K3 preview below. apslar,80,Capsule,200000002113,5weden, 100000000535, 11648,23/12/2021,0,
5 |623b9138-2¢75-4alif-8861-9c50b766e226, Antirobe vet. 150 mg Ka apslar, 16,Capsule,200000002113,5weden, 100000000535,11648,23/12/2021,0,
6 Delimiters
7 [J1ab
: [ semicolon [] Treat consecutive delimiters as one
comma
u [1icomma Text qualifier: S
1 [1 space
12 M
Other:
13 -
14
15 .
16 Data preview
17
18
19 roduct Identifier roduct Name
cbObEfb-9d20-464d-abbe-9£5ds0ebbeas [FUREX Combi 15.5 mg/g / 77.5 mg/g oroug|
20 cbObEfb-9d20-464d-abbe-9£5dS0ebbeas [FUREX Combi 15.5 mg/g / 77.5 mg/g oroug|
21 23b8138-2C75-4a6£-3861-9c5007662a26 Antirobe vet. 150 mg Kapsel; hérd
22 23b9138-2C75-4a61-3861-9C5007662a26 Antirobe vet. 150 mg Kapsel: hird
23
24 < >
25
26 Cancel < Back Finish
27
" " [ = " H o 3 A H .
E. Press "Next" and then "Finish" to complete the conversion. The result should be a correctly delimited Excel file as it is displayed below:
File Home Insert Pagelayout Formulas Data Review View Help {1 Comments 2 Share
Cut o = = — AutoSum v
& Calibri = = E v EQ; Wrap Text % General ﬁ @ Ej @ E):( @ %? @
®copy ~ o Gt~ ’
Paste B I U- Merge & Centre ~ Sensitivity = % 9 0 Conditional Formatas Cell Insert Delete Format Sort & Find & Analyse
v <¥ Format Painter = 9 v ® 420 Formatting ¥ Table ¥ Styles ¥ v - v 6> Clear v Filter ¥ Select ¥ Data
Clipboard N Font N Alignment | Sensitivity Number N Styles Cells Editing Analysis
019 - f
O Internal \ All EMA Staff and Contractors /' Private Public Internal  ~  Confidential - Restricted
A B T D E F G H | J K L M N ] P Q R s T u v W X

Product Identifier

1

2 |5cb0b6fb-9d20-464 FUREX Cor 600000150555 ES/V/036(54ade196 Carton bo: 1 Syringe 200000002150 Cyprus 100000000375 GR123

3 |5cb0b6fb-9d20-464 FUREX Cor 600000150555 ES/V/036(54ade196 Carton bo: 1 Syringe 200000002150 Spain 100000000529 GR123

4 623b9138-2c75-4al Antirobe v 600000161870 Not availa 20fd7a88- Tryckférpz 80 Capsule 200000002113 Sweden 100000000535 11648 23/12/2021
5 |623b9138-2c75-4at Antirobe v 600000161870 Not availa451fd721- Tryckfarpz 16 Capsule 200000002113 Sweden 100000000535 11648  23/12/2021

Product N; Permanent Iden Authorisat Package IcPackage [ Pack size_Pack size_Pack size_Unit (Country  Country Identifi Marketing Creation Date Availability Stat Availability Status Date
08/12/2021 100000072075 08/12/2021
08/12/2021 100000072075 08/12/2021

0
0
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3. How to change the Decimal and Thousands separator in MS Excel

As soon as the format is fixed and the comma separated values (CSV) file is properly delimited, the Decimal and Thousands separators should be changed.

Otherwise, Excel will replace ',' with ';' as soon as save is pressed.

The following steps should be performed:
A. Navigate to File — Options in Excel;

B. Select Advanced as it is shown in the following image:

Excel Options
General
Advanced options for working with Excel.
Formulas
Data Editing options
Proofing ~| After pressing Enter, move selection
Save Direction: | Down ~
Language Automatically insert a decimal point

R Places: 2
Ease of Access

Enable fill handle and cell drag-and-drop
Advanced .
~| Alert before overwriting cells

4

Customize Ribbon ~| Allow editing directly in cells
CQuick Access Toolbar ~| Extend data range formats and formulas
o ~| Enable automatic percent entry
Add-ins .

~| Enable AuteComplete for cell values
Trust Center

~| Autematically Flash Fill
Zoom on roll with IntelliMouse

~| Alert the user when a potentially time consuming operation occurs

When this number of cells (in thousands) is affected: | 33,554

Decimal

Thousands separator: .
Cursor movement:
® |ogical
Visual

Do not automatically hyperlink screenshot

Cut, copy, and paste

-
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C. Uncheck "Use system separators", change Decimal separator to '.", Thousands separator to ',' and press "OK" button to proceed:

Excel Options ? X
General . . . sl
E Advanced options for working with Excel.
Formulas
Data Editing options
Proofing ~| After pressing Enter, move selection
Save Direction:
Language Autematically insert a decimal point L

Ease of Access

Advanced

Customize Ribbon

Add-ins

Trust Center

Quick Access Toolbar

Places: 2

Enable fill handle and cell drag-and-drop

~| Alert before overwriting cells

Allow editing directly in cells

Extend data range formats and formulas

Enable automatic percent entry

Enable AutoComplete for cell values

~| Automatically Elash Fill

Zoom on roll with IntelliMousze

Alert the user when a potentially time consuming operation cccurs
When this number of cells (in thousands) is affected:
Use system separators

Decimal separator: l:l

Thousands separator: E

Cursor movement:

® |ogical
Visual

Do not automatically hyperlink screenshot

Cut, copy, and paste

0K

|| Cancel |
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4. How to change the default Date format for your workstation

In case the date format displayed for CSV files opened with MS Excel application, is not the desired one, please perform the following steps:

A. Click the Windows Start button at the bottom left corner of your screen

B. Click on the Settings

C. From the Region tab, select the “Additional date, time & regional settings”
D

Select the “Change date, time or number formats” option

E. The Region window will open as shown below, from where you can define the date format.

Important note: Please note that this change to the date format will affect how all dates will be presented in your computer and not only the

ones displayed in the MS Excel file.

¥ Region X
Formats  Administrative
Format:

English (Europe) o

Language preferences

Date and time formats

Short date: dd/MM/yyyy v
Long date: dddd, d MMMM yyyy ~
Short time: HH:mm ~
Long time: HH:mmss v
First day of week: | Monday v
Examples

Short date: 11/04/2023

Long date: Tuesday, 11 April 2023

Short time: 16:18

Long time: 16:18:40

Additional settings...
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5. How to check the correct format of the submission file

Please note that when converting an Excel or other spreadsheet file type into the CSV format, the correct type of CSV file format must be chosen: "CSV UTF-
8 (Comma delimited) (*.csv)”.

When an Excel file is converted back to a CSV file, the file format can be checked by opening the file in a simple text app such as Notepad to ensure that it is
commas (without surrounding spaces) which separate the values. If creating a CSV file, from for example a database, ensure that this program does not
create invalid values e.g., on the last line. If a Windows computer was used where the setting for the list separator was not set to comma, then it will be
necessary to replace the list separator with Notepad to comma. You can use the default available “"Replace” functionality and select to use any separator

character to comma as depicted below

Find what E || FindNext
Replace with: | | Replace
Replace All
Cancel
[ IMatch case

[]Wrap around
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